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Chapter 1 – Using These Instructions 

Audience 
This document is intended for users who are installing or migrating to SAS Cost and Profitability 
Management 8.4. This document has been updated for the second maintenance release, SAS Cost 
and Profitability Management 8.4M2. 

Overview 
This document contains the following major sections:  

Chapter 2, “Deployment Options,” explains the common configurations that are supported. 

Chapter 3, “Migrating from Previous Versions,” contains steps for migrating from SAS Activity-
Based Management 7.x or SAS Cost and Profitability Management 8.1 or 8.3 to 8.4M2. These steps 
must be performed before you install the new version. 

Chapter 4, “Migrating Model Data,” describes steps for migrating model data from SAS Cost and 
Profitability Management 8.3 and earlier to version 8.4M2. These tasks must be performed before 
and after you install the new version. 

Chapter 5, “Setting Up Users, Groups, and Ports,” provides an overview of the users and groups 
that are necessary to install and run SAS Cost and Profitability Management. 

Chapter 6, “Installing Third-Party Prerequisites,” contains steps for installing prerequisite 
software that is not supplied by SAS. 

Chapter 7, “Installing SAS Prerequisites,” contains information for installing other SAS 
components on computers in your SAS Cost and Profitability Management deployment. 

Chapter 8, “Installing SAS Cost and Profitability Management,” walks you through an 
installation of SAS Cost and Profitability Management. 

Chapter 9, “Post-Installation,” describes steps to create the data sources, perform any desired 
data migration, and test the installation. 

Multiple appendices have also been included to help you with third-party database configuration 
and selecting tuning options for improved performance. 

Technical Support 
Visit the SAS Technical Support website at https://support.sas.com for installation 
updates. 

For product documentation, visit the SAS Technical Support Documentation website at 
https://support.sas.com/documentation/onlinedoc/abm/index.html. 

https://support.sas.com/
https://support.sas.com/documentation/onlinedoc/abm/index.html
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Conventions Used in this Guide 
Words in examples that are italicized are meant to be replaced by information specific to your 
system. 

For instance, on Windows, replace SASHOME with the path where you installed SAS.  If you 
installed SAS in Program Files on your D: drive, replace SASHOME with d:\Program 
Files\SASHOME. 

On UNIX, replace SASHOME with the path where you installed SAS. If you installed SAS on the 
/opt path, replace SASHOME with /opt/SASHOME/.  

Likewise, CONFIGHOME is the directory that you selected to store your configuration data during 
SAS installation, appended with the configuration level that you are currently using. By default, 
SAS uses the directory C:\SAS\Config\ for Windows. Most users will use Lev1 for the 
configuration level. Thus a typical value for CONFIGHOME is C:\SAS\Config\Lev1. 

Thus, on Windows the text CONFIGHOME\Applications typically equates to 
C:\SAS\Config\Lev1\Applications.  

On UNIX, CONFIGHOME equates to the path where your configuration is installed. If you installed 
on the /opt path and used a configuration name of Config and Level 1, replace CONFIGHOME 
with /opt/SAS/Config/Lev1. 

Reference Documents 
This installation document is not intended to provide sufficient knowledge of the SAS software 
installation process to begin installing SAS Cost and Profitability Management. The SAS 
Deployment Wizard and SAS Deployment Manager 9.4: User’s Guide is required reading before you 
begin. It is available at 
https://support.sas.com/documentation/installcenter/en/ikdeploywizug/66034/
PDF/default/user.pdf  
You also need a document that lists the minimum supported software versions for SAS Cost and 
Profitability Management 8.4 to ensure that any prerequisites that you install are compatible with 
SAS Cost and Profitability Management. The SAS Cost and Profitability Management 8.4M2 System 
Requirements document is available at 
https://support.sas.com/documentation/onlinedoc/abm/index.html.  
Keep this document handy, as it will be referenced repeatedly during the installation process. We 
recommend printing a copy for easy access. 
SAS Cost and Profitability Management might be the first product at your site that requires SAS 
9.4. You might be using a 9.2/9.3-based Metadata Server and Web Report Studio as part of your 
existing SAS Activity-Based Management 7.x installation. If so, you must migrate all SAS 9.3 (or 
earlier) components to be used by SAS Cost and Profitability Management 8.4 to version 9.4. 
Refer to the SAS 9.4 Intelligence Platform Migration Guide at  

https://documentation.sas.com/doc/en/pgmsascdc/v_044/engsas7bdat/p0xntq65hj
j4jkn1nrryzly5fm7u.htm for more information. 

The SAS 9.4 Intelligence Platform Installation and Configuration Guide contains a wealth of 
information about SAS software installation. It is available at 
https://documentation.sas.com/?docsetId=biig&docsetTarget=biigwhatsnew94.ht
m&docsetVersion=9.4&locale=en. 

The SAS 9.4 Intelligence Platform: System Administration Guide provides detailed information about 
managing users and groups. It is available at 
https://documentation.sas.com/?docsetId=bisag&docsetTarget=bisagwhatsnew94.

https://support.sas.com/documentation/installcenter/en/ikdeploywizug/66034/PDF/default/user.pdf
https://support.sas.com/documentation/installcenter/en/ikdeploywizug/66034/PDF/default/user.pdf
https://support.sas.com/documentation/onlinedoc/abm/index.html
https://documentation.sas.com/doc/en/pgmsascdc/v_044/engsas7bdat/p0xntq65hjj4jkn1nrryzly5fm7u.htm
https://documentation.sas.com/doc/en/pgmsascdc/v_044/engsas7bdat/p0xntq65hjj4jkn1nrryzly5fm7u.htm
https://documentation.sas.com/?docsetId=biig&docsetTarget=biigwhatsnew94.htm&docsetVersion=9.4&locale=en
https://documentation.sas.com/?docsetId=biig&docsetTarget=biigwhatsnew94.htm&docsetVersion=9.4&locale=en
https://documentation.sas.com/?docsetId=bisag&docsetTarget=bisagwhatsnew94.htm&docsetVersion=9.4&locale=en
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htm&docsetVersion=9.4&locale=en.The SAS 9.4 Intelligence Platform: Security Administration 
Guide provides detailed information about security in the SAS 9.4 Intelligence Platform. It is 
available at 
https://documentation.sas.com/?docsetId=bisecag&docsetTarget=bisecagwha
tsnew94.htm&docsetVersion=9.4&locale=en 

The SAS Visual Analytics documentation is available at the following website: 
https://support.sas.com/documentation/onlinedoc/va/index.html.   

Finally, an alphabetical listing of all available SAS product documentation is available at 
https://support.sas.com/en/documentation/all-products-documentation.html. 

Release Notes 
Be sure to check https://support.sas.com/documentation/onlinedoc/abm/index.html 
for the updated Release Notes. This document contains late-breaking information related to 
installation, configuration, and defects. 

 

https://documentation.sas.com/?docsetId=bisag&docsetTarget=bisagwhatsnew94.htm&docsetVersion=9.4&locale=en
https://documentation.sas.com/?docsetId=bisecag&docsetTarget=bisecagwhatsnew94.htm&docsetVersion=9.4&locale=en
https://documentation.sas.com/?docsetId=bisecag&docsetTarget=bisecagwhatsnew94.htm&docsetVersion=9.4&locale=en
https://support.sas.com/documentation/onlinedoc/va/index.html
https://support.sas.com/en/documentation/all-products-documentation.html
https://support.sas.com/documentation/onlinedoc/abm/index.html
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Chapter 2 – Deployment Options  
SAS Cost and Profitability Management supports many server configurations. Deployment 
architecture is typically selected based on the expected workload. If you are migrating from SAS 
Activity-Based Management 7.x and want to change the deployment architecture, contact SAS 
Technical Support. 

An Integrated Windows Authentication-enabled (IWA) deployment is now an option. For more 
information about IWA deployments, refer to the following documents: 
https://documentation.sas.com/?docsetId=bisecag&docsetTarget=n0go7pclcq
r6q2n1bxfuk46hmtdy.htm&docsetVersion=9.4&locale=en 

https://documentation.sas.com/?docsetId=bimtag&docsetVersion=9.4&docset
Target=p1871e69gmwdr0n1o182krslc10p.htm&locale=en 

First, we define a few terms: 

Middle-Tier Server – Hosts the SAS Cost and Profitability Management middle-tier software. This 
includes the SAS Cost and Profitability Management web services, database access logic, 
and some of the business rules that provide SAS Cost and Profitability Management 
functionality. This server accesses the Database Server and OLAP Server. In addition, it 
calls the Model Server to perform calculation tasks and creates cubes using the OLAP 
Server.  

Database Server – Hosts the SAS Cost and Profitability Management database. SAS Cost and 
Profitability Management 8.4 supports Microsoft SQL Server, PostgreSQL, and Oracle 
databases. 

OLAP Server – An OLAP server responding to multidimensional query requests from an OLAP 
viewer such as the one built into SAS Cost and Profitability Management and SAS 
Enterprise Guide. SAS Cost and Profitability Management supports both the SAS OLAP 
Server and Microsoft SQL Server Analysis Services.  

For installation and configuration purposes, we refer to the SAS Cost and Profitability 
Management OLAP Server as the computer where the SAS PROC OLAP runs or the 
computer where Microsoft SQL Server Analysis Services runs – not as the computer that 
responds to requests from an OLAP viewer. This slight distinction signifies that SAS 
cubes can be built on one computer while multidimensional query requests are handled 
by a separate computer where SAS OLAP Server is installed. 

This server is typically called a SAS Server. The SAS installation process installs the entire 
Base SAS system on this server, along with specific components required by SAS Cost 
and Profitability Management, such as the SAS OLAP Server. However, if you instead 
use Microsoft SQL Server Analysis Services (SSAS) for OLAP processing, the OLAP 
Server may not need any SAS software. For brevity, we refer to this logical server as the 
OLAP Server, but a more appropriate name might be the OLAP Cube Creation Server. 

Model Server – Hosts the SAS Cost and Profitability Management models and most of the business 
logic. This is the server that performs the actual calculation logic for SAS Cost and 
Profitability Management.  

https://documentation.sas.com/?docsetId=bisecag&docsetTarget=n0go7pclcqr6q2n1bxfuk46hmtdy.htm&docsetVersion=9.4&locale=en
https://documentation.sas.com/?docsetId=bisecag&docsetTarget=n0go7pclcqr6q2n1bxfuk46hmtdy.htm&docsetVersion=9.4&locale=en
https://documentation.sas.com/?docsetId=bimtag&docsetVersion=9.4&docsetTarget=p1871e69gmwdr0n1o182krslc10p.htm&locale=en
https://documentation.sas.com/?docsetId=bimtag&docsetVersion=9.4&docsetTarget=p1871e69gmwdr0n1o182krslc10p.htm&locale=en
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Metadata Server – Hosts the SAS Metadata Server, and may host other SAS applications as well, 
such as the SAS Web Infrastructure Platform and the SAS Foundation Services. These 
products are part of the SAS Business Intelligence architecture. SAS Cost and Profitability 
Management uses the Metadata Server to store information about SAS Cost and 
Profitability Management users, perform user authentication, and to share data with 
other applications, such as SAS Visual Analytics. It is also used by SAS OLAP Server to 
store cube and security information. Finally, it centralizes access to SAS Workspace 
Servers, so they can be shared among SAS Business Intelligence applications. 

For clarity, this document refers to the five logical servers in italics with their name capitalized to 
distinguish its usage. For example, this document will use Model Server when referring to your 
logical deployment; but will use “model server” when referring to a specific computer or server. 

Next, we will discuss how these logical servers can be installed onto physical computers. The SAS 
Cost and Profitability Management architecture does not specify how the five servers listed 
above map to one or more physical computers. Select a deployment topology that best suits your 
requirements. The topologies discussed below are the most common, but they do not enumerate 
all possibilities. Discuss the suitability of any of these topologies with SAS consultants. In order 
of smallest expected workload to largest, they are:  

Two-Server Deployment 
This deployment is suitable for small installations where:  

• The number of SAS Cost and Profitability Management users with Create Models and 
View Models roles is relatively small.  

• Both the SAS Cost and Profitability Management models and their cubes are small.  
• Integration with other applications, such as SAS Web Report Studio, is not required. 
• Microsoft SQL Server Analysis Services are used for OLAP processing.  

All server machines are running on Microsoft Windows. 

In this deployment, the two computers host the SAS servers in the following manner:  

• Server 1: Middle-Tier Server, Metadata Server, and Model Server. If your site already has a 
SAS Metadata server installed, SAS Cost and Profitability Management should share 
your existing server.  

• Server 2: Database Server and OLAP Server.  

Three-Server Deployment 
This deployment is suitable for mid-size installations. It meets requirements similar to the Two-
Server Deployment discussed previously, except that the models are now large enough or the 
number of users is large enough that sharing one computer between the Middle-Tier Server and 
the Model Server is no longer practical. This deployment is feasible only if the Workspace Server is 
not heavily used by other SAS applications.  

In this deployment, the three server machines host the servers in the following manner:  

• Server 1: Middle-Tier Server and the Metadata Server. If your site already has a metadata 
server installed, SAS Cost and Profitability Management should share your existing 
server. 

• Server 2: Database Server and OLAP Server  
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• Server 3: Model Server  

Four-Server Deployment  
This deployment is suited to high-usage installations. It moves the database, OLAP processing, 
and calculation onto computers that are separate from the web application server.  

• Server 1: Middle-Tier Server  
• Server 2: Database Server and OLAP Server  
• Server 3: Model Server 
• Server 4: Metadata Server. If your site already has a Metadata Server installed, SAS Cost 

and Profitability Management should share your existing server.  
A SAS workspace server should also be installed on the OLAP server if SAS OLAP Server is used 
to process cubes. This allows the cube creation, cube storage, and cube delivery to be hosted on a 
single computer.  

Five-Server Deployment  
This deployment is suited to very high-usage installations. It moves the database, OLAP 
processing and calculation processing onto computers separate from the Middle-Tier Server.  

• Server 1: Middle-Tier Server  
• Server 2: Database Server  
• Server 3: OLAP Server  
• Server 4: Model Server 
• Server 5: Metadata Server. If your site already has a metadata server installed, SAS Cost 

and Profitability Management should share your existing server.  

Other Deployment Options 
The previously described deployment scenarios represent a few of the possible options. 
Depending on the number of SAS Cost and Profitability Management users at your site, the size 
of your models, and the size of the cubes they generate, other topologies are feasible. The key to 
choosing an appropriate topology is to understand the usage patterns and task loading of the 
computers in the deployment.  

For specific recommendations on hardware sizing based on your deployment, modeling, and 
performance needs, a formal analysis through SAS Enterprise Excellence Center is required. 

Note: HTTP by default is not secure, and user credentials are sent in clear text. Configure TLS to secure 
the connections (HTTPS). Make sure that you are validating the server certificates (MS 
CHANNEL). Verify that HTTPS conforms to data-in-motion standards. 
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Server Prerequisites 
Each of the four logical servers, plus the Metadata Server, in a SAS Cost and Profitability 
Management deployment has its own specific software prerequisites. Some of these are third-
party requirements, such as a relational database, and others are SAS requirements, such as a 
SAS/ACCESS engine for data access. These prerequisites are documented in the SAS Cost and 
Profitability Management 8.4M2 System Requirements. When logical servers are installed on a single 
physical computer, do not duplicate the prerequisites, except where explicitly noted.  

Deployment Information 
Use the following table to record information about the machines in your deployment. 

Type of Server Machine Name Operating System Machine Description 

Middle-Tier Server     

Model Server     

Database Server       

OLAP Server    

Metadata Server    

Before You Begin 
SAS recommends that you disable any antivirus software that is running on your server while 
you are performing the SAS installation. On rare occasions, antivirus software prevents some 
required files and settings from installing successfully. 

 

https://support.sas.com/en/software/cost-and-profitability-management-support.html#documentation
https://support.sas.com/en/software/cost-and-profitability-management-support.html#documentation
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Chapter 3 – Migrating from Previous Versions 
This chapter is intended for existing SAS Activity-Based Management 7.x customers, SAS Cost 
and Profitability Management 8.1 and 8.3 customers who want to install the most recent version, 
or for SAS 9.2 or 9.3 users who are new to SAS Cost and Profitability Management. If none of 
these criteria describes your site, you can skip this chapter. 

If you presently use SAS 9.3 or earlier software, you must first update it to SAS 9.4.  

If you have SAS Activity-Based Management 7.x or SAS Cost and Profitability Management 8.1 
or 8.3 software, follow the steps in this document to migrate to SAS Cost and Profitability 
Management 8.4M2.  

In addition, if you do not currently have any version of SAS Activity-Based Management 
installed, you cannot migrate your existing SAS 9.3 system to 9.4 and add SAS Cost and 
Profitability Management 8.4 at the same time. To add SAS Cost and Profitability Management to 
your installation, first migrate your existing SAS installation to SAS 9.4, and then run the SAS 
Deployment Wizard a second time to add SAS Cost and Profitability Management 8.4. 

Important Changes from Previous Versions of SAS Activity-Based 
Management 

A few important changes in SAS Cost and Profitability Management 8.4 will affect users of 
previous versions of SAS Activity-Based Management: 

• SAS Cost and Profitability Management 8.4 requires SAS 9.4. Older versions of SAS 
components that support SAS Cost and Profitability Management, such as a Metadata 
Server, must also be migrated to SAS 9.4. 

• SAS Cost and Profitability Management 8.4 no longer supports Microsoft SQL Server 
2000 or 2005 databases. It no longer supports Microsoft Analysis Services 2000 or 2005 for 
OLAP. 

• SAS Cost and Profitability Management 8.4 no longer supports Oracle 10g database. 

• Cubes that were built with SAS OLAP Server 9.2/9.3 are compatible with SAS OLAP 
Server 9.4. However, the cube names that are created by SAS Cost and Profitability 
Management 8.4 have changed from previous versions. This change makes the cubes 
easy to recognize if you access them from outside of SAS Cost and Profitability 
Management, but it also requires you to delete any cubes from an older version of SAS 
Activity-Based Management and recreate them in SAS Cost and Profitability 
Management 8.4. 

• Even if you are migrating from SAS Cost and Profitability Management 8.x, you need to 
recreate your cubes in SAS Cost and Profitability Management 8.4. 

For detailed version information regarding supported third-party tools, refer to the SAS Cost and 
Profitability Management 8.4 System Requirements. 

https://support.sas.com/en/software/cost-and-profitability-management-support.html#documentation
https://support.sas.com/en/software/cost-and-profitability-management-support.html#documentation
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Backing up the System 
Before you start the upgrade, you must back up your database. If you are using Microsoft SQL 
Server, back up the OEModels databases (or the name that you selected for this database when 
you installed your back-level version of SAS Activity-Based Management or SAS Cost and 
Profitability Management). If you are using Oracle, you must back up the schema that you 
created for SAS Activity-Based Management 7.x or SAS Cost and Profitability Management 8.x 
during the installation.  

Before you back up the databases, verify that no one is using SAS Activity-Based Management or 
SAS Cost and Profitability Management on the target servers. 

Warning: Database backups are specific to a version of SAS Cost and Profitability Management. Do 
not restore the current SAS Cost and Profitability Management databases from a backup 
created from a previous version. Include the version number in the backup filename. 

In addition to the SAS Activity-Based Management databases, create a backup of the directory 
that contains the Published Reports that were created by SAS Activity-Based Management users. 
It is a best practice to retain a copy of all published reports. This folder is located at: 
SASHOME\Activity-Based Management Solution\Enterprise 
Server\SasSolutions\ABM\Reports\Published.  

Note:  The Published Report feature is not supported in SAS Cost and Profitability Management 
8.4.  

You should also back up all your current-version SAS data prior to migrating any of the SAS 
components to 9.4. For more information, refer to the SAS 9.4 Intelligence Platform Migration Guide. 

Upgrading from SAS OLAP 9.2 or 9.3 
Cubes that were built with SAS OLAP Server 9.2/9.3 are compatible with SAS OLAP Server 9.4. 
However, the cube names that are created by SAS Cost and Profitability Management 8.4 have 
changed from previous versions. This change makes the cubes easy to recognize if you access 
them from outside of SAS Cost and Profitability Management, but it also requires you to delete 
any cubes from an older version of SAS Activity-Based Management and recreate them in SAS 
Cost and Profitability Management 8.4. For more information, refer to the SAS 9.4 Intelligence 
Platform Migration Guide. 

Upgrading from Microsoft Analysis Services 2005 
For more information, see Appendix C - Third-Party Migration. 

Upgrading from Microsoft SQL Server 2005 
Data from Microsoft SQL Server 2005 can be moved to later versions of Microsoft SQL Server. See 
“Migrating from SQL Server 2005” in Appendix C - Third-Party Migration for more information. 

Migrating SAS Activity-Based Management Models 
See Chapter 4 – Migrating Model Data for the steps to migrate models to the current version. 
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Running the SAS Migration Utility 
Follow the instructions in the SAS 9.4 Intelligence Platform Migration Guide for migrating your 
existing SAS 9.2 or 9.3 Intelligence Platform. Once you have migrated your SAS Business 
Intelligence Platform to version 9.4, continue with these instructions to complete your 
installation. When the software installation has completed, the final step of the installation 
process migrates your existing SAS Activity-Based Management data to the new 8.4 format.  

Migrating from Releases of 8.x to 8.4M2  
If you are migrating from any SAS Cost and Profitability Management 8.x release to SAS Cost 
and Profitability Management 8.4M2, you must export the current models using the Export 
Model functionality of SAS Cost and Profitability Management before starting the migration. The 
migration process will not migrate the model data. After the migration process is complete, you 
must use Import Model functionality of SAS Cost and Profitability Management to access your 
models. The migration process migrates the model metadata, but it does not migrate actual 
models. If a model has been published, then unpublish the model before exporting it.  

After you migrate or perform an upgrade in place to SAS Cost and Profitability Management M2, 
when you try to log in to the client, you might receive the following error: 

 
If you see this error, take the following steps: 

1. Stop the SAS Object Spawner.  

2. Navigate to the Models directory path, which is typically 
SASConfig/Lev1/SASApp/ABMServer/Models on the compute tier. 

3. Rename the M0 folder to M0_rename. 

4. Start SAS Object Spawner.  

5. Log back in to the client. 

After migration when a user logs in to SAS Cost and Profitability Management, the models are 
displayed, but they lack the actual model data. Each displayed model shows only the model 
metadata that was migrated. If the user tries to open these models, an error is displayed that 
states, “Failed to load data from SAS Cost and Profitability Management 
Server.”  

If this occurs, the user should import the already exported model. An important first step is to 
rename the model.abm file for each model. These model Memory Mapped Files (MMF) are 
located under the Models folder mentioned previously in step 2. While importing the model, 
select the option Existing model (for an XML import) or Existing model along with the option to 
Replace all data in the model, then import new data (for a Database Import). The selection of 

https://go.documentation.sas.com/doc/en/pgmsascdc/v_044/engsas7bdat/p0xntq65hjj4jkn1nrryzly5fm7u.htm?fromDefault=
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these options ensures that the model metadata is connected to the actual model data that is being 
imported. After the import has completed successfully, the user can open the model.  

Before starting the migration, the user should also export the cube configurations. These 
configurations need to be imported using the Import Cube Configuration functionality in SAS 
Cost and Profitability Management. 

For more information about these import features, refer to the User’s Guide. 
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Chapter 4 – Migrating Model Data 
This chapter is intended for SAS Activity-Based Management 7.x users or SAS Cost and 
Profitability Management 8.x users. If you are new to SAS Cost and Profitability Management, 
you can skip this chapter. 

If you are migrating from SAS Activity-Based Management 7.x, at this point in the installation 
process, you should already have one of the supported database versions installed. This database 
should also contain your SAS Cost and Profitability Management model data from a previous 
version of SAS Activity-Based Management. This process is described in Appendix C - Third-
Party Migration on page 61. 

Important:  Make sure that you have backed up your data before proceeding! In addition to performing a 
database backup, SAS also recommends exporting the models to a safe place.  

Migrating from Version 8.x 
On Linux systems, if you are not doing an in-place migration–that is, if you want to keep the 
existing 8.x version of the software running–you must change directory permissions on 
CONFIGHOME/SASApp/ABMServer/Models and CONFIGHOME/SASApp/ABMServer/Logs 
after the migration. This step is required to enable the Model Server external user to read and 
write to the contents of the two directories. 

If the external Model Server user is part of the same group, you can run the following command: 

chmod –R 775 Models folder Logs folder 

No special steps are required on Windows systems.  

You have two options to migrate SAS Cost and Profitability Management data from an earlier 
version of the software: 

• Export data from the previous version and import it into SAS Cost and Profitability 
Management 8.4M2: This is the simplest and most common approach. You export the 
required models and related data from the previous version and import them into SAS 
Cost and Profitability Management 8.4M2. You must specify a fresh database schema 
during the migration. No special post-installation steps are required. 

• In-place database migration: You can also update the data in your existing database to 
the format used by SAS Cost and Profitability Management 8.4M2. This method requires 
you to point to your old database during the migration and select the “Upgrade” option. 
After the in-place migration, refer to Chapter 3 – Migrating from Previous Versions for 
information about migrating the model data. 

Migrating from Version 7.x 
You have two options to migrate SAS Cost and Profitability Management data from an earlier 
version of the software: 

• Export data from the previous version and import it into SAS Cost and Profitability 
Management 8.4M2: This is the simplest and most common approach. You export the 
required models and related data from the previous version and import them into SAS 
Cost and Profitability Management 8.4M2. You must specify a fresh database schema 
during the migration. No special post-installation steps are required. 
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Note: If you were using a MySQL database with your previous version of SAS Activity-Based 
Management, exporting is the only supported way to migrate your data to SAS Cost and 
Profitability Management 8.4M2. 

• In-place database migration: You can also update the data in your existing database to 
the format used by SAS Cost and Profitability Management 8.4M2. This method requires 
you to specify your old database during the migration and select the Upgrade option. 

Migrating in place from version 7.x to 8.4 is mostly handled by the SAS Migration Utility. After 
the installation, you must run the Model Migration Utility, which is discussed in Chapter 9 – 
Post-Installation. 

If you are not migrating data, some post-installation steps are required. These steps are described 
in Chapter 9. 
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Chapter 5 – Setting Up Users, Groups, and Ports 
Before you begin the installation, you must have a user account available to install the SAS 
software. In addition to user accounts, SAS Cost and Profitability Management has a few third-
party prerequisites and requires specific port settings. The following sections explain how to 
create the necessary user accounts and groups on the operating system and describe how to set 
their permissions. 

Warning: While reading this chapter, be aware that using “local” users for tasks other than software 
installation can cause authentication problems when software is deployed on multiple 
computers. (In Windows terminology, “local” users are defined on a local computer and do 
not have network or domain authentication.) These problems arise because a local user on 
one computer is invisible to software on another computer – even if the same user accounts 
are created with identical passwords on each computer. If resources and access privileges on 
one computer require authentication on another computer, that user must have network 
authentication.  

The following sections describe the user accounts that SAS and third-party software require, and 
they answer the following questions: 

• What are internal and external user accounts? 
• What user rights are required, or to what groups must each account be assigned? 
• Should I create local or network directory service accounts? 

Types of User Accounts 
Two types of user accounts are required when deploying SAS:   

• Internal user accounts are accounts known only to SAS and are created and authenticated 
internally in metadata rather than externally via an operating system.  

• External user accounts are user accounts defined outside of SAS metadata. These accounts 
are local to a machine or are defined in a network directory service of which the machine 
is a member, such as LDAP. 

Internal Accounts 
Internal user accounts are known only to SAS and are created and authenticated internally in 
metadata rather than externally. SAS identifies internal accounts by appending a special string to 
the user ID. This string begins with an “at” sign (@) and contains the characters saspw. For 
example: @saspw. For two of the required user accounts, the SAS Administrator and the SAS 
Trusted User, the SAS Deployment Wizard prompts you by default to create internal user 
accounts.  

Access to these two internal accounts is not required for day-to-day usage of SAS Cost and 
Profitability Management. However, you will need them to administer your SAS Cost and 
Profitability Management installation.  

For more information about internal accounts, see “Understanding the State of Your System” in 
the SAS Intelligence Platform: System Administration Guide. 
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External Accounts 
External user accounts are defined outside of SAS metadata. These user accounts are local to a 
machine or are defined in a network directory service of which the machine is a member, such as 
LDAP or a Windows domain.  

SAS requires external user accounts for two purposes: installation and running some SAS server 
processes. During installation and configuration, the SAS Deployment Wizard must run under an 
external account with the necessary privileges on the target computer to write SAS program and 
log files. To run servers such as the stored process server and the pooled workspace server, SAS 
requires an external user account to be the server process owner. For more information about 
external user accounts, see the SAS Intelligence Platform: System Administration Guide. 

As you create these external user accounts, record information about them in the table provided. 
You will need this information when you run the SAS Deployment Wizard to install SAS Cost 
and Profitability Management and other SAS software. 

Key Points 
Some discussions of user accounts that follow in this document refer to internal accounts, and 
others refer to external accounts. References to internal accounts or groups implicitly mean items 
that are stored in a SAS metadata server. References to external accounts or groups implicitly 
mean items stored within an operating system. 

Model Server and OLAP Server Accounts 
The external accounts and external groups discussed in this chapter must be accessible to the SAS 
Cost and Profitability Management Model Server and, if you are using SAS OLAP Server, on your 
OLAP Server as well. 

They are also required on other SAS servers in your deployment, but they are not required on 
your database server, nor are they required on your OLAP Server if you are using Microsoft SQL 
Server Analysis Services. 

In addition to any external accounts that SAS requires, an external account is required for the 
model server. A network account is required unless the Metadata Server and the Model Server 
are installed on the same machine and require administrator privileges on the Model Server.  

Creating External User Accounts 
SAS Cost and Profitability Management requires an external user account for: 

• the software installer 
• each SAS Cost and Profitability Management user. At minimum, one account is required for 

an initial user. 
• SAS Cost and Profitability Management IOM Server account.  

In this guide, iomuser is the user name for this account and is helpful for identifying it 
easily. However, iomuser is only an example user name. Select a name that is meaningful 
for your deployment. 

Other SAS software also needs an external account to run the SAS Spawned Servers. However, 
SAS Cost and Profitability Management does not use SAS Spawned Servers, so that account can 
be ignored for purposes of installing SAS Cost and Profitability Management.  
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Note:  Do not confuse the SAS Spawned Server with the SAS Object Spawner. 

You can install your SAS software using any operating system account that has sufficient 
privileges. However, SAS recommends using the same user account to install all SAS software, to 
install all third-party prerequisites, to uninstall software, and to apply any required updates.  

SAS recommends recording the account IDs that you use in the following table: 

Account 1 Recommended User ID Actual User ID 

SAS Installer 
Windows: my-domain\installer-ID2  

UNIX: sas 3  

1. For information about these user accounts, see “Rights Required by External User Accounts for 
SAS” in SAS 9.4 Intelligence Platform: Installation and Configuration Guide. 

2. On Windows, the user ID should be available in the future to facilitate SAS maintenance. 
3. On UNIX, do not use root. 

Operating systems require you to assign certain rights to the external user accounts that are used 
to deploy and to run SAS. The following table describes the user rights that are required by the 
external user accounts to deploy and run SAS: 

Account Operating System User Rights Needed 

SAS Installer 
Windows Administrator rights 

UNIX Member of a group that is the primary group for the 
SAS Spawned Servers account1 

4. SAS Cost and Profitability Management does not use any SAS Spawned Servers user accounts. 
However, other SAS products might use them. If you do create a Spawned Servers account, it 
must also be a member of a group that is the primary group for the SAS Installer account. 

On Windows, if you select to run your SAS servers using management scripts—instead of 
running them as Windows services—the user account that runs the SAS Spawned Server must 
meet the following requirements on the Spawned Server machine: 

• be the administrator or a member of the Windows Administrators group 
• have the following Windows local user rights: 

o Adjust memory quotas for a process 

o Replace a process level token 

When you set up passwords for your SAS system users, SAS recommends configuring passwords 
that do not have to be reset at the first login. It is also preferable to configure the passwords for 
these accounts not to expire.  

Windows 

On a Windows server, follow these steps if you need to create a local SAS Installer User. If you 
already have a local account for this purpose, or if you plan to use a network account, skip these 
steps. Otherwise, you need to create this local user on each computer where SAS software will be 
installed: 

1. Start → Control Panel → Administrative Tools → Computer Management.  

2. Expand the System Tools. 

3. Expand Local Users and Groups and right-click Users. Select New User… 

4. Supply a username for the installation user that you selected. 

https://go.documentation.sas.com/?docsetId=biig&docsetVersion=9.4&docsetTarget=n02002intelplatform00install.htm&locale=en#n02006intelplatform00install
https://go.documentation.sas.com/?docsetId=biig&docsetVersion=9.4&docsetTarget=n02002intelplatform00install.htm&locale=en#n02006intelplatform00install
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5. Supply descriptions (SAS Installer User) and a password. 

6. Clear the option User must change password at next logon. 

7. Select the option User cannot change password. 

8. Select the option Password never expires. 

9. Click Create, and then click Close. 

UNIX 
Use the appropriate system utilities to add a user account with the following characteristics: 

• Add a user 
• Set a password for the user (passwd NewUser) 
• Set the expiration date to 99999 

SAS First User Account (Optional) 
To validate your SAS deployment, you need an external user account that represents a SAS Cost 
and Profitability Management user. This account must be the temporary process owner when its 
jobs are run on a standard workspace server.  

This “SAS First User” is typically a SAS Cost and Profitability Management user whose account 
will be used to validate the installation. However, you have the option to create a temporary 
external account whose sole purpose is validation. You can enable the SAS Deployment Wizard 
to create an internal SAS First User account for you and prompt for the First User’s external 
account credentials.  

Creating External Groups 
Certain operating-system privileges must be granted to users who will run SAS processes. They 
must be granted on each computer where these processes will run. All SAS Cost and Profitability 
Management modeler users must be able to launch batch processes on the Model Server. In 
addition, if you are using SAS OLAP Server, users who create cubes must be able to launch batch 
processes on the Model Server and the OLAP Server. 

On UNIX and Windows, adding users to a group and then granting that group the proper 
permissions simplifies the management of multiple users. 

Full Name Recommended Group ID Actual Group ID 

SAS Server Users 
Windows: SAS Server Users  

UNIX: sas  

 

Windows 
Create a new external group (not a metadata server group), and add each SAS Cost and 
Profitability Management user to the group of SAS server users. If you are creating a SAS First 
User account, add it to this group as well. 

Warning: Failure to add each SAS Cost and Profitability Management user to the group of SAS server 
users on the required computers will cause calculation and cube-generation tasks to fail. 
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Perform these steps on each computer in your deployment where you will install SAS software. 
For a typical SAS Cost and Profitability Management installation, this means the Model Server and 
the OLAP Server, if SAS OLAP is used: 

1. Click Start→Control Panel→Administrative Tools→Computer Management.  

2. Expand Systems Tools. Expand Local Users and Groups. Right-click Groups, and select 
New Group to create a new group using the SAS Server Users name you selected.  

Note:  Networked user accounts are required if the metadata server is on a separate machine 
from the other SAS Servers. 

3. Close Computer Management. 

Finally, grant Log on as a batch job to this group. Take the following steps: 
1. Bring up the Local Security Settings dialog by double-clicking Administrative Tools → 

Local Security Policy in the Control Panel. 

2. Select Local Policies → User Rights Assignment. 

3. Right-click Log on as a batch job and select Properties. 

 
4. In the Log on as batch Properties dialog box, click Add User or Group.  

5. In the Select Users or Groups dialog box, click the Object Types button to search for 
groups on the local computer.  

 
6. In the Object Types dialog box, verify that the Groups check box is selected, and click 

OK.  

7. Click Locations.  

8. In the Locations dialog box, verify that your local computer name is selected. The local 
computer name usually appears at the top of the list. Click OK. 

9. Type a name for the SAS Server Users in the Enter the object names to select field. Select 
Check Names. Click OK. 

10. Click OK to close the Log on as batch Properties dialog box. 

UNIX 
If you are installing any SAS software on a UNIX system, create a UNIX group to store the ID of 
the SAS Server User. SAS recommends that you name this group sas. The system command to 
add members is useradd –G GroupName UserName. 
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Designating Ports 
Review the set of ports that the SAS servers and third-party servers in your system will use by 
default. If any of these ports are unavailable in your environment, possibly because of conflicts 
with other software, select alternate ports and record them in the following table. 

Only the ports that are used by SAS Cost and Profitability Management are included in this list. 
For more information about SAS software ports, refer to “Designating Ports and Multicast 
Addresses” in the SAS 9.4 Intelligence Platform: Installation and Configuration Guide. 

Server 
Default 

Port 
Actual 

Port 
Machine Name 

Middle-Tier SAS Web Server 8080   

Database Port (select one): 
• Microsoft SQL Server 
• Oracle 
• PostgreSQL 

 
14333 
15213 
103323 

  

OLAP Server Port (select one): 
• Microsoft SQL Server Analysis Services 
• SAS OLAP Server1 

 
N/A 4 
5451 

  

SAS Metadata Server 8561   

SAS Workspace Server2 8591   

SAS Deployment Tester Server 10021   

SAS Cost and Profitability Management “Operations” 5081   

SASApp Cost and Profitability Management Server 6785   

SAS Cost and Profitability Management “Windows 
Service Port” 

9050 
  

SAS Foundation Services5 5091   

1. This port is for the Workspace server on the OLAP Server (if SAS OLAP Server is in use). 
2. This port is for the Workspace server on the Model Server. 
3. The default port for the default instance. If you create a named instance, the port might differ. 
4. Microsoft SQL Server Analysis Services does not use a port for creating connections. Specify an 

instance name if it is not running on the default instance.  
5. This is usually located on the Metadata Server 

The default port assignment is based on a clean installation of the product on a machine where: 

• no other instances of that product are installed 
• no other versions of that product are running 
• no similar products are running (for example, web servers) 

Observe these restrictions because the default ports may have been reassigned during the 
installation. Verify the port assignment before continuing with the SAS Cost and Profitability 
Management installation. 

https://go.documentation.sas.com/?docsetId=biig&docsetVersion=9.4&docsetTarget=n02027intelplatform00install.htm&locale=en#n02006intelplatform00install
https://go.documentation.sas.com/?docsetId=biig&docsetVersion=9.4&docsetTarget=n02027intelplatform00install.htm&locale=en#n02006intelplatform00install
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Warning: The port assignments on any single computer cannot conflict. SAS port assignments may be 
duplicated across computers because the connection between components or services on 
different computers consists of the computer name and port number. 
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Chapter 6 – Installing Third-Party Prerequisites 
This chapter provides an overview for the installation of the third-party software prerequisites 
that will be needed by the SAS Cost and Profitability Management installation. These instructions 
are not intended to replace the OEM instructions for the software, but are instead intended to 
provide an overview for important options and installation choices that SAS Cost and 
Profitability Management relies on for proper operation. 

Important: Not all of these prerequisites are required on all servers. Follow the instructions carefully to 
avoid installing unnecessary software. 

Before installing the SAS Cost and Profitability Management software on the Middle-Tier Server, 
verify that the other servers in your deployment have the third-party software prerequisites and 
SAS software prerequisites installed. Record the following information during the installation 
process for reference purposes: 

• computer names 
• newly created user accounts and passwords 
• installation directories 
• a check-mark to indicate that the software has been installed 

Verify that you are installing these prerequisites using the proper SAS Installer user account that 
was identified in the previous chapter. 

This information is required to configure the SAS Cost and Profitability Management server so 
that it can communicate with the other servers. Use the tables below to record the information as 
your installation proceeds: 

Middle-Tier Server – Machine Name: 

Prerequisite Software Installed? Installation Directory 

SAS Cost and Profitability 
Management Middle-Tier1 

  

Database access software2   

Microsoft .NET3   

1. The installation instructions for this component are in Chapter 8 – Installing SAS Cost and 
Profitability Management. 

2. JDBC driver for SQL Server, Oracle or PostgreSQL. 
3. .NET is required only if you are using SQL Server Analysis Services for OLAP. 

Database Server – Machine Name: 

Prerequisite Software Installed? Instance/GDB Name 

Relational Database    
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OLAP Server (if using SAS OLAP Server 1) – Machine Name: 

Prerequisite Software Installed? 

SAS Cost and Profitability Server Tier3  

Database access software2  

1. Includes Base SAS with PROC OLAP, SAS OLAP Server, and Workspace Server. 
2  An ODBC driver for a SQL Server, Oracle, or PostgreSQL database. 
3  The full name is SAS Cost and Profitability Management Data Integration and Enterprise BI Server. 

This component will be installed in Chapter 8. This can also be any existing SAS OLAP Server. 
 

OLAP Server (if using SQL Server Analysis Services 1) – Machine Name: 

Prerequisite Software Installed? 

SQL Server Analysis Services  

Database Connectivity Tools1  

1. Either Microsoft Client Connectivity Tools or Oracle Administrative Client Tools.  
 

Model Server – Machine Name: 

Prerequisite Software Installed? 

SAS Cost and Profitability Management 
Server1 

 

Database access software2  

SAS/ACCESS to ODBC  

SAS/ACCESS to Oracle (if using an 
Oracle database) 

 

SAS/ACCESS to PostgreSQL (if using a 
PostgreSQL database) 

 

1. Includes Base SAS with SAS/GRAPH, and Workspace Server as key components 
2  The Microsoft Client Connectivity Tools for SQL Server; Oracle Administrative Client Tools; or an 

ODBC driver for PostgreSQL.  

 

Metadata Server – Machine Name: 

Prerequisite Software Installed? Internal Account Password 

SAS Metadata Server    

SAS Foundation Services    

 

Verify that these prerequisites have been met before you install SAS Cost and Profitability 
Management. Or, if they are to be installed on the same computer as SAS Cost and Profitability 
Management, install them simultaneously. 

User ID for Installations 
Verify that you are logged in as the SAS Installer User before proceeding.  
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Relational Database  
A relational database is a required prerequisite for the Database Server in your deployment. 

The SAS Cost and Profitability Management 8.4 Solution needs a relational database to store its 
data. Select one of the following databases and install it:  

• Microsoft SQL Server database (for Windows)  
• PostgreSQL database (for Windows and UNIX)  
• Oracle database (for Windows and UNIX) 

If you have already installed a database, verify the port number for the database and record it in 
the table provided in “Designating Ports” in the previous chapter.  

Use the following table to record the installation details for the database: 

Database user name Password Database/Schema name 

    
 

Installing Microsoft SQL Server Database 
Skip this section if you are upgrading from a previous version of SAS Activity-Based 
Management and if you are using a version of SQL Server that is supported by SAS Cost and 
Profitability Management 8.4M2. However, you will need the SQL Server user’s name and 
password, and the database name that contains your existing data. Record this information in the 
table above. You will need it later when you install SAS Cost and Profitability Management 
8.4M2 and when you update your database to the 8.4 schema format. 

Background Information 
Microsoft has changed terminology over the last several releases of SQL Server. In SQL Server 
2000, the OLAP server was named Microsoft Analysis Services (MSAS), but starting with SQL 
Server 2005, it is called SQL Server Analysis Services (SSAS). This should not be confused with 
SAS OLAP Server.  

In addition, in SQL Server 2000 the connectivity drivers (ODBC, OLEDB, etc.) and management 
console were combined into the Client Tools installation. In recent versions of SQL Server, 
Microsoft bundles them differently. Refer to your Microsoft SQL Server documentation and be 
sure to select appropriate options during SQL Server installation to include connectively tools.  

Important:  If you are using Microsoft SQL Server for your database or Microsoft SQL Server Analysis 
Services for your OLAP processing, your Middle-Tier Server must be running on 
Windows. This is a configuration limitation caused by user authentication limitations 
between UNIX and Windows. 

Install Microsoft SQL Server 
Refer to the Microsoft documentation for the steps to install SQL Server. 

Configure Microsoft SQL Server 
Refer to the Microsoft documentation for the steps to set up SQL Server.  
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Install Oracle Database  
Refer to the Oracle documentation for the steps to install Oracle Database. 

Warning: The Oracle installer performs a few prerequisite tests. Make sure all tests successfully 
complete. If any tests fail, refer to the Oracle installation guide for help. This is especially 
important because, depending on your hardware configuration, the Oracle database may 
require the presence of a Loopback Adapter for proper operation. If the Loopback Adapter is 
not installed but its presence is required by Oracle, the Oracle database will appear to 
operate properly most of the time. However, SAS has determined that random failures, 
typically involving “concurrency” (to quote the Oracle error messages), will occur. The 
Oracle documentation has instructions for installing the Loopback Adapter on your 
operating system. 

Install PostgreSQL Database 
If your software order indicates that you are planning to use PostgreSQL with SAS Cost and 
Profitability Management, the database will be included with the SAS software and installed by 
the SAS Deployment Wizard. 

If you are using the PostgreSQL database on a non-English environment, you must add the 
parameter “PGCLIENTENCODING=UTF8” to your environment variables. If it is not added, then 
generate cubes can fail with a transcoding error. 

OLAP Server 
If you are using SAS OLAP Server, you may skip this section. You will install it in Chapter 7. 

If you are using Microsoft SQL Server Analysis Services, install it on the computer that you have 
identified as the OLAP Server in your SAS Cost and Profitability Management deployment. If you 
are using Microsoft SQL Server Analysis Services and your OLAP Server and Database Server are 
deployed on one computer, you may have already installed the OLAP software. If so, you can 
skip this section. 

Microsoft SQL Server Analysis Services  
Refer to the Microsoft documentation for the steps to deploy SQL Server Analysis Services. 

ODBC Drivers 
The Model Server uses ODBC drivers to access the database. Likewise, if you are using the SAS 
OLAP Server to create SAS Cost and Profitability Management cubes, the OLAP Server 
deployment also uses the ODBC drivers to access the database. Keep the following points in 
mind: 

• If your OLAP Server is running on a 32-bit operating system, a 32-bit ODBC driver is 
required on the OLAP Server.  

• Likewise, you need a 64-bit ODBC driver for an OLAP Server running on a 64-bit 
operating system.  

• In contrast, the Model Server requires 64-bit ODBC driver. This is true regardless of the 
operating system or the “bit-ness” of the operating system on your Database Server. 
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If you are using Microsoft SQL Server Analysis Services to create SAS Cost and Profitability 
Management cubes, the OLAP Server does not require ODBC drivers, but it does need the Client 
Connectivity tools for your database.  

Important:  SAS recommends installing the ODBC drivers using the Client Connectivity Tools options 
that are available on your database installation media for Microsoft SQL Server and Oracle 
databases. Using these options guarantees that the Model Server, as well as the   drivers, 
will receive any updates as part of a database update provided by your vendor. 

Important:  Windows distinguishes between 32-bit and 64-bit ODBC drivers. Windows also 
distinguishes between 32-bit DSNs and 64-bit DSNs. The 32-bit DSNs can only use 32- bit 
ODBC drivers, and 64-bit DSNs can only use 64-bit ODBC drivers. 

Microsoft SQL Server Database 
To download the drivers directly, search for the “Microsoft SQL Server Feature Pack” at the 
following website: https://www.microsoft.com/en-us/download/. Download the drivers 
for the version of SQL Server that you are using with SAS Cost and Profitability Management.  

Oracle Database 
If you need to download the ODBC drivers directly, the “Oracle Data Access Components” for 
Oracle can be found at 
https://www.oracle.com/technology/software/tech/windows/odpnet/index.html. 

Important:  If the Model Server is installed on a UNIX computer, SAS Cost and Profitability 
Management includes the required ODBC drivers for Oracle database. For more 
information, see Appendix F – ODBC Data Sources on Linux. 

PostgreSQL Database 
The ODBC drivers for PostgreSQL are automatically included when SAS Cost and Profitability 
Management is installed with the PostgreSQL option. If you need to download the ODBC drivers 
directly, they can be found at the following website: 
https://www.postgresql.org/ftp/odbc/versions/msi/. 

Important: If the Model Server is installed on a UNIX computer, SAS Cost and Profitability 
Management includes the required ODBC drivers for PostgreSQL database. For more 
information, see Appendix F – ODBC Data Sources on Linux. 

Required Software for SAS Cost and Profitability Management Client 
The following software is required for each SAS Cost and Profitability Management client:  

Microsoft .NET Framework 
The Microsoft .NET 4.8 Framework is required by the SAS Cost and Profitability Management 
client. The .NET Framework is installed by SAS installer. A separate installation is not required. 

You can download the .NET Framework from https://www.microsoft.com/en-
us/download/. 

 

https://www.microsoft.com/en-us/download/
https://www.oracle.com/technology/software/tech/windows/odpnet/index.html
https://www.postgresql.org/ftp/odbc/versions/msi/
https://www.microsoft.com/en-us/download/
https://www.microsoft.com/en-us/download/
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Microsoft XML Core Services 
Microsoft XML 6.0 Parser (MSXML) is installed as part of Microsoft Office and does not typically 
require a separate installation. 

If necessary, it can be downloaded from https://www.microsoft.com/en-us/download/. 

OLEDB for OLAP Drivers 
Client computers require a driver to access OLAP data sources and to display OLAP cubes. 

If you are using SAS OLAP Server to create cubes, you need the SAS OLEDB for OLAP 9.4 driver. 
This driver is included as part of the SAS Cost and Profitability Management Client installation. 

Otherwise, download the Microsoft SQL Server Feature pack to get the Microsoft OLEDB for 
OLAP driver. You can go to https://www.microsoft.com/en-us/download/ and search for 
“Microsoft SQL Server Feature pack” to download the version you require. 

WSE 3.0 
The Client computer requires Web Services Enhancements (WSE) 3.0. If you are installing the 
client software on Windows 8 or a later version, you must install WSE 3.0. You can install it from 
the SAS Software Depot. 

Special Combinations 

Microsoft SQL Server Database and Microsoft Analysis Services 
If you are using Microsoft SQL Server, you may experience unresolved table locking problems in 
your SQL Server database that prevent SAS Cost and Profitability Management batch processes 
from completing. The error states: 

Transaction (Process ID 58) was deadlocked on lock resources with 
another process and has been chosen as the deadlock victim. Rerun 
the transaction. 

This problem most commonly appears when SQL Server is heavily loaded and SAS Cost and 
Profitability Management is generating cubes. 

To resolve this problem, modify your database transaction isolation level.  

1. Launch the SQL Server Management Studio from the Start menu. 

2. Make sure you have selected Database Engine and the computer where your database 
engine is running. Log into SQL Server Management Studio using an appropriate 
administrative account. 

3. Open a query window: click the New Query button on the toolbar. 

4. Paste the following query into the query window and change the text 
MyCPMDatabaseName to be the name of your SAS Cost and Profitability Management 
database: 

ALTER DATABASE MyCPMDatabaseName SET READ_COMMITTED_SNAPSHOT ON 

5. Select Execute. 

 

https://www.microsoft.com/en-us/download/
https://www.microsoft.com/en-us/download/
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Chapter 7 – Installing SAS Prerequisites 
After completing the steps in Chapter 6 – Installing Third-Party Prerequisites, you now have all 
of the third-party software prerequisites installed and configured properly on the physical 
computers in your deployment. The next step is to install your SAS software. 

If you are new to installing SAS software, the process involves two components: 

• The software to be installed – a SAS Software Depot 
• A “Plan file” that describes the SAS software to be installed on each computer. This file 

helps to simplify complex installations. 

Your SAS software order was delivered with a sample Plan file that is suitable for the 
deployment information you provided when you ordered your software. If you want to change 
that deployment, contact a SAS representative. 

Verify that you are installing the software discussed in this chapter using the SAS Installer User. 

SAS Software 
As part of your SAS software purchase, you receive a Software Order E‐mail detailing the specific 
software included in your order, download instructions (or DVDs if requested) and a SAS 
Installation Data file (SID file) to activate your software. You will need this email to continue with 
the installation. The Software Order E‐mail is sent to the SAS Installation Representative at your 
site. If you cannot locate your Software Order E‐mail, visit the SAS Support website at 
https://support.sas.com/techsup/license to have the email re‐sent to the SAS 
Installation Representative.  
During the installation, you must have access to the SAS Software Depot and Plan file. Keep 
these in a location that is accessible to all the machines. 

Download your software into the SAS Software Depot using either the SAS Download Manager 
or the DVDs that you received from SAS.  

For information about the SAS Software Depot, refer to the Quick Start documents at: 

• https://support.sas.com/documentation/installcenter/en/ikqsgbasicesd/
66208/PDF/default/quickstart.pdf (“basic” deployments) or  

• https://support.sas.com/documentation/installcenter/en/ikqsgplanesd/6
6210/PDF/default/quickstart.pdf (deployments using a SAS “Plan” file).  

Use the SAS Deployment Wizard to install the software from the SAS Software Depot. The Install 
Center website provides more information about all aspects of SAS software installation: 
https://support.sas.com/en/documentation/install-center/94.html 

SAS Software Installation 
Follow the SAS Deployment Wizard instructions carefully and type your responses accurately. 
Correctly specifying port numbers, usernames, and machine names is critical.  

Using the SAS Deployment Wizard, install the required SAS software that you identified in 
Chapters 3 and 4 on the appropriate OLAP Server and, if required, on the Metadata Server. These 
two servers may not require software installations. For example, if you are using Microsoft SQL 
Server Analysis Services, the OLAP Server installation is already complete.  

https://support.sas.com/techsup/license
https://support.sas.com/documentation/installcenter/en/ikqsgbasicesd/66208/PDF/default/quickstart.pdf
https://support.sas.com/documentation/installcenter/en/ikqsgbasicesd/66208/PDF/default/quickstart.pdf
https://support.sas.com/documentation/installcenter/en/ikqsgplanesd/66210/PDF/default/quickstart.pdf
https://support.sas.com/documentation/installcenter/en/ikqsgplanesd/66210/PDF/default/quickstart.pdf
https://support.sas.com/en/documentation/install-center/94.html
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Similarly, if your site already has a SAS 9.4 Metadata server installed, it is possible that the only 
SAS software packages that you must install are the Model Server and the Middle-Tier Server, both 
of which are discussed in the next chapter. But it is also possible that only the Database Server 
installation is complete. 

Your Plan file will help you efficiently install the SAS software where it is required. If your Model 
Server will run on the same computer as the Middle-Tier Server, an accurate Plan file allows for 
this configuration and installs the software together. Your Plan file can also enable you to install 
the OLAP Server and Metadata Server simultaneously. 

Warning:  If you have a SAS Plan file specifying that SAS software should be deployed on two separate 
computers, you may be tempted to run the SAS Deployment Wizard to install “Software 1” 
on Computer A and then run it a second time to install “Software 2” on the same computer. 
If you install your software this way, make sure you specify different configuration 
directories for each run of the Deployment Wizard. If you try to co-locate multiple sets of 
configuration files in a single directory, the configuration data from a subsequent 
installation can overwrite the previous configuration data, resulting in a non-functioning 
system.  

During the installation, update the configuration tables in Chapter 5 with port information, 
usernames, and other data to identify your deployment. 

Important:  If you are installing in a locale other than English, follow the instructions that are available 
at the following websites for locale-specific settings: 

• SAS 9.4 Intelligence Platform: Installation and Configuration Guide 

• Multilingual Computing with SAS 9.4 

If these settings are not correct, SAS Cost and Profitability Management might not work 
properly. 

Important Deployment Questions 
Several options in the SAS Deployment Wizard impact your entire installation. This section 
reviews those options and provides guidance to make informed decisions. You may see all of 
these choices when installing your software or you may see none of them. The options depend on 
the software that you are installing and the target computers. 

Run as Windows Services (Windows Only) 
If you are installing on a Windows operating system, you have the option to run selected 
software as a Windows service or by manually executing “management scripts.”  

No performance penalty is associated with either choice. The decision instead affects how you 
manage your deployment. The advantage of Windows services is that the operating system can 
automatically stop and restart them when Windows is shut down or restarted.  

The advantage of executing management scripts is that you decide when to start them, and you 
have direct access to any startup parameters provided by these scripts. However, if you decide to 
use management scripts, be aware that you must manually stop and start these tasks yourself 
when Windows is shut down or restarted. If these tasks are not running, the SAS applications do 
not run properly.  

http://go.documentation.sas.com/?docsetId=biig&docsetTarget=n05002intelplatform00install.htm&docsetVersion=9.4&locale=en#n05087intelplatform00install
http://support.sas.com/resources/papers/Multilingual_Computing_with_SAS_94.pdf
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SAS recommends that these tasks be run as Windows Services so they will automatically start 
when the computer is restarted. Otherwise, they must be manually started by an administrator or 
by means of a script that runs after a restart of the computer. 

Allow Anonymous Web Access 
The option to Allow Anonymous Web Access is often dependent on the site-wide security policy 
at an enterprise. Check with your IT department about its web access policies. If you do not have 
a specific need to allow anonymous access, SAS recommends that you leave this option disabled. 

Automatically Configure Your Web Application Server 
SAS Cost and Profitability Management and other SAS applications use a web application server 
to host portions of their application. You have the option to let the SAS configuration process 
automatically configure the application servers, or you can perform those steps manually after 
the SAS configuration has completed. The steps that you must manually perform are written to 
the instructions.html file that is generated for each computer in your deployment. For typical 
installations, SAS recommends letting the web application servers be automatically configured. 

Configure Multiple Managed Servers 
SAS Cost and Profitability Management 8.4 requires multiple-managed servers. SAS Cost and 
Profitability Management 8.4 typically goes under SASServer9, and the server should not be 
shared with any other SAS solutions. 

SAS Software to Install 
The installation instructions for the SAS Metadata Server and the SAS OLAP Server are not 
included in this guide. Refer to the SAS 9.4 Intelligence Platform Installation and Configuration Guide 
for more information. 

The SAS Deployment Wizard asks for a computer name multiple times. Unless you are 
specifically prompted for an abbreviated name, provide a fully-qualified name. Fully qualified 
names are usually of the form: <MyComputerName>.<MyCompanyName>.com or perhaps 
<MyComputerName>.<MyRegion>.<MyCompanyName>.org. Here is an example: 
sasserver.eur.webcomputers.com. Abbreviated names are usually a simple name, such as 
<MyComputerName> or simply sasserver. Do not add forward or backward slashes as prefixes to 
these names. Consult with your IT support staff if you are uncertain about the proper format for 
your installation. 

Warning:  SAS Cost and Profitability Management 8.4 does not support pooled workspace servers. 
When configuring a SAS OLAP Server for SAS Cost and Profitability Management, select a 
non-pooled workspace server. 

Metadata Server 
The Metadata Server is the first machine to install, configure, and have running. It is used to store 
and share information about all the other computers where you install SAS software. 

Typical SAS installations share a Metadata Server. If you already have a functioning SAS 9.4 
Metadata Server for another SAS deployment, do not install another unless you are creating 
multiple, independent environments—as, for example, when isolated Test and Production 
environments are created to partition work streams. 

http://documentation.sas.com/?docsetId=biig&docsetTarget=biigwhatsnew94.htm&docsetVersion=9.4&locale=en
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Record the options that you selected while installing the SAS Metadata Server. Information about 
the Host Name and Port is required to install SAS Cost and Profitability Management.  

OLAP Server 
Important:  If you already have a SAS OLAP Server installed, you can share it with SAS Cost and 

Profitability Management. You can also decide to install a dedicated instance for SAS Cost 
and Profitability Management. Unless prohibited by your product license, select the 
deployment that best suits your requirements. 

You can skip this installation if you are using Microsoft SQL Server Analysis Services for cube 
processing. For more information about the SAS OLAP Server, refer to its documentation at 
https://support.sas.com/documentation/onlinedoc/olap/index.html. 

The SAS Cost and Profitability Management configuration creates the CPM Library in the SAS 
Metadata Server. This library uses the DSN definition on the OLAP Server to connect to the SAS 
Cost and Profitability Management database. If the OLAP Server and Calculate Server are hosted 
on the same computer, they share the DSN. If they are hosted on separate computers, each 
computer requires an identical DSN definition. For more information about DSNs, see “Creating 
Data Source Names (DSNs)” in Chapter 9. 

 

SAS Visual Analytics Server 
If your deployment includes a SAS Visual Analytics server, refer to the relevant documentation at 
https://support.sas.com/software/products/va/index.html.  

Important: If you are planning to use SAS LASR Analytic Server on a separate machine, take the 
following steps to set up a database connection: 

6. Configure a workspace server on the SAS Visual Analytics Server machine to push data 
from SAS Cost and Profitability Management to SAS LASR Analytic Server. You can find 
more information about SAS Visual Analytics server configuration at 
https://support.sas.com/software/products/va/index.html. 

7. On the SAS Visual Analytics Server machine, create a system DSN that points to the 
database server. If the SAS Visual Analytics Server is running on Linux, use the required 
ODBC drivers provided by SAS to create the DSN. You can copy these drivers from other 
machines (such as the Mid-Tier machine or IOM tier) onto this machine. For more 
information about DSN configuration, see “Creating Data Source Names (DSNs)” in 
Chapter 9 and “Appendix F – ODBC Data Sources on Linux.” 

8. Configure the user who will push the data to the SAS LASR Analytic Server. This user 
requires the ‘Log on as batch job’ property on the SAS Visual Analytics server. For more 
information about this property, see “Creating External Groups” in Chapter 5.  

 

https://support.sas.com/documentation/onlinedoc/olap/index.html
https://support.sas.com/software/products/va/index.html
https://support.sas.com/software/products/va/index.html
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Chapter 8 – Installing SAS Cost and Profitability Management 
This chapter guides you through the installation of SAS Cost and Profitability Management 8.4 
on the computer that you identified as the Application Server in your deployment. The SAS Cost 
and Profitability Management installation assumes that one of the following situations applies: 

• You have all the other servers in your SAS Cost and Profitability Management 
deployment installed and properly running, or 

• The other servers in your deployment will be installed on the same computer as your 
SAS Cost and Profitability Management Middle-Tier Server. In other words, you are going 
to install them now. 

The following sections describe the important steps in the SAS Deployment Wizard. Some wizard 
dialog boxes seem to ask for redundant information. If your Plan file installs several components 
on a single computer, all the configuration steps for each component are displayed – even if some 
of the information is redundant. 

Installing on UNIX 
The SAS Deployment Wizard that is used to install SAS Cost and Profitability Management is an 
X window application. If you are installing from a personal computer, set up the display to your 
personal computer. For example: 

DISPLAY=yourcomputer_absolute_address:0.0 

export DISPLAY 

Interactive Prompting Levels 
After you start the SAS Deployment Wizard, you are asked to select a wizard prompting level: 

• Express – displays the minimum number of dialog boxes to complete the configuration 
• Typical – displays the basic set of dialog boxes to complete the configuration 

• Custom – displays all the dialog boxes to complete the configuration 

The following table lists the configuration options and the prompt level at which they display for 
SAS Cost and Profitability Management.  

Note: Your deployment will include additional configuration options. The configuration options you 
see depend on the SAS products that are identified in your deployment plan, and on the target 
machine where you are installing software. 

SAS Deployment Wizard Option  Express Typical Custom 

OLAP Server Options X X X 

Workspace Server for Cube and Model Server X X X 

Operations Port X X X 

Database Options X X X 

Database Connectivity and Upgrade Options X X X 

Junit and SAS Environments Options X X X 

ODBC and Database Server Options X X X 
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Installing the SAS Cost and Profitability Management Model Server 
When you are ready to install the software, launch the SAS Deployment Wizard and browse to 
select your Plan file. Verify the presence of “SAS Cost and Profitability Management IOM Server 
Configuration” in the Deployment Wizard dialog box to ensure that the SAS Cost and 
Profitability Management Server is configured on the computer that will host the Model Server. 

 
Before you configure the Model Server, configure the Logical Workspace Server, which is used by 
SAS Cost and Profitability Management Server. When you configure the Middle-Tier Server, you 
are prompted for the name of the Logical SAS Workspace Server.  
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The wizard also prompts you for information about the SAS Cost and Profitability Model Server.  

  
The following information is required: 

Host Name: The machine name where the Model Server will be installed. 

Port: The port that is used by the Model Server. 

External User ID: The external user ID that is used to launch Model Server. For more 
information, see “Model Server and OLAP Server Accounts” in Chapter 5. 

Password: The password of the user account that is used to launch the Model Server. 

Note: If you are deploying SAS Cost and Profitability Management on top of an existing SAS 
installation (an add-on installation) and your deployment includes SAS Visual Analytics, you 
must select a few additional components during configuration. The section of the SAS Visual 
Analytics 7.3: Installation and Configuration Guide (Distributed LASR) that is titled “Adding 
SAS Visual Analytics Components to Your System,” available at 
https://support.sas.com/documentation/onlinedoc/va/7.3/en/vaicg.pdf, 
shows the additional components to select during configuration. These components must be 
included and selected for configuration with the SAS Cost and Profitability Solutions Mid-Tier 
LASR Configuration component so that it can receive the dependent data that it requires from 
SAS Visual Analytics High-Performance Configuration. 

Installing the SAS Cost and Profitability Management Middle Tier 
The SAS Deployment Wizard enables you to select the computer from your Plan file that will 
host the Middle-Tier Server. Verify the presence of “SAS Cost and Profitability Management 
Middle-Tier” in the list. 

https://support.sas.com/documentation/onlinedoc/va/7.3/en/vaicg.pdf


SAS Cost and Profitability Management 8.4 

 

34 

 
The SAS Deployment Wizard walks you through the installation. When you begin to configure 
the web application server, you will have 0 – 7 web application servers to configure before the 
Web Application Server: Managed Server dialog box opens. The actual number depends on 
your Plan file.  

Select the option to Configure multiple servers on the Web Application Server: Multiple Servers 
dialog box. 

 
The Ninth Server Configuration dialog box (shown below) corresponds to the web application 
server for SAS Cost and Profitability Management. 
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The wizard then prompts you to configure the Cost and Profitability Management Data Server.  

 
The SAS Cost and Profitability Management Data Server corresponds to the PostgreSQL 
database. Select this option if you plan to use PostgreSQL. SAS OLAP Server is then configured 
automatically. 

If you do not select the PostgreSQL database, the wizard prompts you for OLAP server 
information.  

 
The following information is required: 

OLAP Server Type: The type of OLAP server to use. This parameter is operating system-specific. 
Select either SAS OLAP Server or Microsoft SQL Server Analysis Services. Refer to the SAS 
Cost and Profitability Management System Requirements for specific limitations and version 
requirements. Microsoft SQL Server Analysis Services is only supported for Microsoft SQL Server 
and Oracle databases. PostgreSQL is not supported. 

Database Type: The relational database to use. Select either Microsoft SQL Server or Oracle. The 
available options are not filtered for the operating system. Refer to the SAS Cost and Profitability 
Management System Requirements for supported deployment options and specific version 
requirements:  

https://support.sas.com/en/software/cost-and-profitability-management-
support.html#documentation 

 

https://support.sas.com/en/software/cost-and-profitability-management-support.html#documentation
https://support.sas.com/en/software/cost-and-profitability-management-support.html#documentation
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If you selected Microsoft SQL Server Analysis Services as an OLAP Server option, a dialog box 
prompts you to configure it. 

 
The following information is required: 

Host: The fully qualified name of the computer that hosts SQL Server Analysis Services. If you 
defined a Default Instance, omit the \<InstanceName> qualifier. Otherwise, specify the 
instance name. 

User ID: A domain account ID that has sufficient privileges to create, delete, and change 
permissions on cubes. If your deployment has the Microsoft SQL Server Analysis Services 
installed on the same computer as the SAS Cost and Profitability Management Middle-Tier Server, 
this can be a local user. If you specify a local user, <MyDomain> is replaced by the short computer 
name. The cube creation process on Microsoft SQL Server Analysis Services runs as this user. 

Note:  Provide limited privileges to this user on the underlying operating system and file system. 

Password: The password for the Analysis Services user. 

Authentication Domain: The authentication account to use for SAS Cost and Profitability 
Management users when creating and updating permissions on cubes that are created by SAS 
Cost and Profitability Management. 

The next configuration step prompts you for port information: 
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The following information is required: 

“Operations” Port: The port that is used by the Middle-Tier Server to communicate with all SAS 
Cost and Profitability Management “operations”. These are long-running processes that perform 
tasks such as importing and exporting model data or performing model calculations. 

Windows Service Port: For Microsoft SQL Server Analysis Services, the port that is used by the 
Middle-Tier Server to communicate with the OLAP cube creation processes. It is not used to 
communicate with Microsoft SQL Server Analysis Services directly. 

Next, specify database connection parameters. 

 
The following information is required: 

Runtime User ID: The database login account for the SAS Cost and Profitability Management 
software to use when accessing the database. This is the database login name from your existing 
SAS Cost and Profitability Management database, or the database login from your new database 
installation. 

Runtime Password: The database user’s password. 

Important:  The databases were installed and configured in Chapter 6. The database and user 
information are required. This information is used to attach to the database and create initial 
tables or to update the existing tables to the latest schema. If this information is incorrect, 
this process does not complete successfully. 

Important:  The password length limit is 64 characters. The following symbols do not work when used in 
passwords. Note that this is not a complete list; there may be additional symbols that do not 
work: 

For Oracle:    ~,!,@,$,%,^,&,*, + 

For PostgreSQL and Microsoft SQL Server:  %, &, + 

Host: The fully-qualified name of the computer that hosts your database. 

Port: The port that your database is configured to use. See “Designating Ports” in Chapter 5 for 
more information. 
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ODBC DSN Name: The Data Source Name (DSN) that the Model Server and SAS OLAP Server use 
to connect to the relational database that you select. By default, the Deployment Wizard suggests 
a default name that includes your configuration level name. Change it if desired. 

Important:  The Model Server and OLAP Server require an appropriate ODBC driver to communicate 
with the relational database that you selected. This driver is operating-system specific. 

Important: If you are performing a clustered deployment for the Middle-Tier Server, the ODBC DSN 
must be configured on each cluster node. In addition, all of the Database Client Connectivity 
Tools must be installed on each node to enable database communications. 

For more information on DSNs, see “Creating Data Source Names (DSNs)” on page 44. 

The next configuration step prompts for database information: 

 
The following information is required: 

Database or Schema Name: The database or the schema name used for the SAS Cost and 
Profitability Management relational database.  

JDBC Jar File: The location of the JDBC driver’s jar file for the selected database. This JDBC 
driver is used by the Middle-Tier Server to communicate with the database. For Microsoft SQL 
Server and Oracle databases, this is the jar file that you installed in Appendix A or Appendix B.  

Net Service Name: Applies to an Oracle database if you have selected Microsoft SQL Server 
Analysis Services for OLAP. Specify the Net Service Name you have designated in your Oracle 
database for SAS Cost and Profitability Management. See “Appendix B – Installing Oracle” for 
more information. 

Global Database Name: For an Oracle database, specifies the Global Database Name that you 
have designated in your Oracle database for SAS Cost and Profitability Management.  

Be careful to specify the Global Database Name correctly. Conventions have changed slightly in 
recent versions of Oracle. The name typically contains the Service Name (alias) or SID (unique 
name of the database instance), followed by the domain suffix. For example, if the Service Name 
is “orcl” and the domain suffix is “na.test.com”, the correct Global Database Name would be: 
orcl.na.test.com  



SAS Cost and Profitability Management 8.4 Installation, Migration and Configuration Guide 

 

39 

However, it is possible to configure the Oracle Global Database Name to be the same as the 
Service Name or the SID. Many default setups for database instances prior to Oracle 11g R2 have 
this configuration.  

If you specify an incorrect Global Database Name, you might see an error similar to the following 
in the SAS Cost and Profitability Management installation log during your SAS Cost and 
Profitability Management installation:  

[echo] java.sql.SQLException: Listener refused the connection with the 

following error: 

[echo] ORA-12514, TNS:listener does not currently know of service 

requested in connect descriptor 

If the database contains previous…: The action to perform if the database already contains SAS 
Cost and Profitability Management models. The two options are as follows: 

• Upgrade existing database 
Examines the version number of SAS Cost and Profitability Management schema in your 
database and updates it to SAS Cost and Profitability Management 8.4M2. This option is 
valid for any SAS Activity-Based Management version 7.x and SAS Cost and Profitability 
Management 8.x. If the existing schema is up-to-date, no action is taken. 

• Reinstall database 
Erases the contents of the existing database and recreates a new, empty database. This 
selection resets the database to a new state and deletes all previous SAS Cost and 
Profitability Management data. No additional warnings are given once the wizard 
proceeds. 

See “Migrating from Version 7.x” in Chapter 4 for more information. 

Do you want to localize…: Whether to localize the names of objects in the SAS Cost and 
Profitability Management database. If you select “True,” the object names in the database are 
localized using the locale setting of your SAS Metadata server. If you select “False,” the database 
object names remain in English. 

Warning:  If you are upgrading from a previous version of SAS Activity-Based Management and you 
selected the option to “Upgrade existing database”, make the same choice here that you made 
when installing the previous version. Otherwise, Saved OLAP Views may not operate 
properly in SAS Cost and Profitability Management 8.4. This happens because the saved 
OLAP Views included localized names in portions of their content. 

The next wizard dialog box, SAS Cost and Profitability Management Middle-Tier 
Dependencies, only displays if you have already installed and configured an operational SAS 
Metadata Server. It queries the Metadata Server to discover other logical workspace servers that 
have been deployed. SAS Cost and Profitability Management can then launch a cube generation 
process on another computer, for example. If you do not have an operational SAS Metadata 
server, these processes run on the local computer. 

SAS Web Infrastructure Platform: The SAS Web Infrastructure Platform to use for the SAS Cost 
and Profitability Management Middle-Tier Server.  

SAS OLAP Server: For the SAS OLAP Server option, the Logical Workspace Server to use for 
running the SAS Cost and Profitability Management SAS OLAP cube building processes. 

SAS Workspace Server: The Logical Workspace Server to use for SAS Cost and Profitability 
Management Model Server.  
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SAS Cost and Profitability IOM Server Configuration: The Model Server to use for SAS Cost and 
Profitability Management Middle-Tier Server, if you have multiple Model Servers defined. 

SAS Cost and Profitability Database Server Configuration: The database configuration to use 
for all SAS Cost and Profitability Management Servers, if you have more than one. 

The next configuration step is the Required Software dialog box: 

 
Junit Jar File: The JAR file that is used by the SAS Cost and Profitability Management 
Diagnostics application. 

Deployment Errors 
If any errors are found during configuration, you can fix them and Retry the operation before 
continuing.  

The Deployment in Progress status box provides information about errors. Each successfully 
installed or configured item has a green check mark. If any errors are displayed during the 
installation or configuration process, click the link in the dialog to view the log file. Search the log 
file for errors by using the key word “error”. The most recent errors or warnings appear at the 
end of the log file.  

The most common error during SAS Cost and Profitability Management configuration is a failure 
to attach to your database or to the sascpmmodels database/schema. If this problem occurs, log 
in to your database management console and verify the database user, the sascpmmodels 
database/schema, and its permissions. Then click Retry on the error dialog box. 

You must resolve any errors before continuing.  

Installing the SAS Cost and Profitability Management Client 
Note:  As with all SAS client products, the SAS Cost and Profitability Management client is 

automatically installed with SAS/SECURE. However, because the client uses HTTP or HTTPS 
communication with the server, SAS/SECURE is optional. Install it if you are using other SAS 
client products, such as the SAS Management Console. 

To install the client, launch the SAS Deployment Wizard and select your Plan file. Verify the 
presence of “SAS Cost and Profitability Management Client” in the list. Then select the computer 
from your Plan file that will host your client applications.  



SAS Cost and Profitability Management 8.4 Installation, Migration and Configuration Guide 

 

41 

 
Depending on the other software that you are installing on your client computers, multiple 
wizard dialog boxes might open. For the SAS Cost and Profitability Management client, only one 
configuration step is important, the Specify URL for Available Servers File dialog box: 

 
SAS Environments URL: The SAS environments file that is used by the SAS Cost and 
Profitability Management client application (and any other SAS clients that you install on this 
computer). The client application uses the environments file to locate other computers in your 
SAS deployment. Refer to SAS 9.4 Intelligence Platform: Middle-Tier Administration Guide for 
information about the SAS environments file. 

Note:  The SAS Cost and Profitability Management client installs EASY API. This API enables the user 
to execute the operations in batch. The passwords that are used in the batch file for EASY API are 
encoded; therefore, this folder must be protected by file system permissions to prevent 
unauthorized access to the credentials. 

After you have installed the Cost and Profitability Management 8.4 client, the old (8.x) client 
will not be deleted. It is retained so that you can preserve any customizations from it. 

 

https://go.documentation.sas.com/?docsetId=bimtag&docsetTarget=n0s325xuzaji9tn16zvgq128dvb5.htm&docsetVersion=9.4&locale=en
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Chapter 9 – Post-Installation 
After installation and configuration, these post-installation steps verify the folder permissions, add 
SAS Cost and Profitability Management users, and test the installation. Make sure you have 
restarted all the server computers before you begin.  

Validating the Installation 
After completing your installation, review and follow the steps in the instructions.html file 
that was automatically generated as part of your installation. A link to this file is provided in the 
final dialog box in the SAS Deployment Wizard. 

Several of the steps in the instructions.html file refer to the detailed instructions provided in 
this chapter. You can skip ahead to the relevant sections in this chapter to complete those steps, if 
necessary. 

Chinese Localization (Windows Client Only) 
The “Chinese (Traditional, Taiwan)” locale is not properly recognized by the SAS Cost and 
Profitability Management client on a Chinese Taiwanese (ZH_TW) Windows operating system. A 
Microsoft bug causes the .NET locale detection mechanism to incorrectly identify this locale as 
“Chinese (Traditional, Hong Kong S.A.R)” (ZH_HK). The Chinese Taiwanese resources are not 
located by the SAS Cost and Profitability Management client program because Windows provides 
an incorrect directory. 

To resolve this problem, after the SAS Cost and Profitability Management client is installed, locate 
the directory where the client is installed, typically “C:\Program Files\SAS\Cost and 
Profitability Management Solution\Cost and Profitability Management 
Solution\Client”. Locate the ZH_TW directory under the client installation folder where the 
resources are installed, and copy that directory, and any subdirectories, to a new directory named 
ZH_HK. Then restart the client program. Your Chinese Traditional localizations should appear as 
expected. 

Important:  Unlike the other post-installation changes outlined in this chapter, perform this modification 
on the Client computers, not on the Server computers. 

Registry Access (Windows Client Only) 
The SAS Cost and Profitability Management client stores settings, such as SAS LASR Analytic 
server configuration, in the Windows Registry on the client machine. If these settings are not 
retained across client sessions, the user might not have the required permissions to update the 
Registry. This issue can occur on Windows 10. To resolve this problem, use one of the following 
options: 

1. Run SAS Cost and Profitability Management client in administrator mode. Right-click on 
the icon and select “Run as Administrator.” If this is not possible, try Option 2: 

2. Give SAS Cost and Profitability Management users access rights to the Windows Registry.  
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Settings are stored in the following Registry paths (users require access to the 
Current_user Registry key and access to the LOCAL_MACHINE section): 

• HKEY_CURRENT_USER\Software\SAS Institute 
Inc.\SASCostandProfitabilityManagement 

• HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\SAS Institute 
Inc.\SASCostandProfitabilityManagement 

Right-click the key and use the Permissions dialog box to grant permissions to each user. 
Important:  Unlike the other post-installation changes outlined in this chapter, perform this modification 

on the Client computers, not on the Server computers. 

Configuring Integrated Windows Authentication (for Thin Clients) 
If your deployment is IWA-enabled, perform the steps that are described in the following link to 
configure web browsers to use IWA: 

https://go.documentation.sas.com/?docsetId=bimtag&docsetTarget=p1871e69g
mwdr0n1o182krslc10p.htm&docsetVersion=9.4&locale=en  

Allocating Memory for the Java Virtual Machine 
When SAS Cost and Profitability Management is configured, a default amount of memory is 
reserved for the Java Virtual Machine (JVM) for use by SAS Cost and Profitability Management 
“operations.” If this setting is too high, the JVM might consume more RAM than necessary (and 
thus reduce the amount of memory available for other tasks on that computer); if it is too low, 
some SAS Cost and Profitability Management tasks can fail due to lack of memory.  

Many SAS Cost and Profitability Management installations will not need to change Xmx. Users of 
small- and medium-sized models (fewer than 25,000 accounts and 100,000 assignments) should 
find the default value sufficient. For more information, see “Adjusting Memory Settings on 
Servers” in Appendix H. 

Managing External Users 
Depending on your deployment, you may have two, and perhaps three, places to manage SAS 
Cost and Profitability Management users and their permissions: 

• The internal users in the SAS Cost and Profitability Management User’s group in the SAS 
Metadata Server 

• The “SAS OLAP server” cube directory (if you are using SAS OLAP Server) 

You can manage access in two ways. You can simply add and remove individual users from these 
locations. Or you can create operating system groups, provide those groups with the required 
privileges to the correct locations, and add users to those groups. If you create domain, or network 
groups, you can manage users from a single location. If you have many SAS Cost and Profitability 
Management users, managing them individually can be error-prone.  

This document provides instructions for managing users individually. If you want to manage 
users by means of groups, the process is similar, except that you first create a group for each 
unique access criterion and then perform the same steps with the group. 

https://go.documentation.sas.com/?docsetId=bimtag&docsetTarget=p1871e69gmwdr0n1o182krslc10p.htm&docsetVersion=9.4&locale=en
https://go.documentation.sas.com/?docsetId=bimtag&docsetTarget=p1871e69gmwdr0n1o182krslc10p.htm&docsetVersion=9.4&locale=en


SAS Cost and Profitability Management 8.4 

 

44 

Creating Data Source Names (DSNs) 
SAS Cost and Profitability Management uses a DSN on the Model Server and OLAP Server to locate 
your SAS Cost and Profitability Management database. 

Microsoft SQL Server 
Take the following steps to create DSNs in a Microsoft SQL Server deployment: 

1. Open Administrative Tools → Data Sources in the Control Panel. 

2. Click the System DSN tab. If a DSN exists with the data source name you provided in the 
SAS Deployment Wizard, delete it: select the DSN name in the list and click Remove.  

3. Create a new DSN by clicking the Add button. 

4. Select the driver name that is appropriate for your database from the list. For Microsoft 
SQL Server 2012, select SQL Server Native Client 11.0.  

5. Click Finish to create the connection. 

6. Enter the data source name that you supplied to the SAS Deployment Wizard. Enter a 
description of this data source in the Description field. SAS suggests using “Connection to 
the SAS CPM database” for the description.  

7. Select the computer, instance name, and port hosting your database from the list labeled 
Which SQL Server do you want. The name is typically entered as ComputerName,Port. 
If you are attaching to a Named Instance of SQL Server, the instance name is not required. 
Because each instance of SQL Server on a computer must be mapped to a unique port, the 
computer name and port number are sufficient to specify the instance of SQL Server to 
connect to. Click Next. 

8. Select SQL Server Authentication and enter the database username and password that 
you provided to the SAS Deployment Wizard for accessing the SAS Cost and Profitability 
Management database. Click Next. 

9. On the next wizard dialog box, select the SAS Cost and Profitability Management 
database as the default database in the Change the default database to field, and click 
Next. 

10. Click Finish. 

11. Select Test Data Source to verify connectivity. Click OK when the connection is verified. 
Click OK to complete DSN creation. 

Note:  The SQL Server native client for SQL Server 2022 has been discontinued. Instead, SAS 
recommends that you use Microsoft ODBC driver or Microsoft OLEDB driver. For more 
information, see: https://learn.microsoft.com/en-us/sql/relational-
databases/native-client/applications/installing-sql-server-native-

client?view=sql-server-ver16. 

PostgreSQL 
Take the following steps to create DSNs in a PostgreSQL deployment: 

1. From the Control Panel, open Administrative Tools → Data Sources. 

2. Click the System DSN tab. If a DSN exists with the data source name that you supplied in 
the SAS Deployment Wizard, edit it by selecting the DSN name in the list and clicking 

https://learn.microsoft.com/en-us/sql/relational-databases/native-client/applications/installing-sql-server-native-client?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/relational-databases/native-client/applications/installing-sql-server-native-client?view=sql-server-ver16
https://learn.microsoft.com/en-us/sql/relational-databases/native-client/applications/installing-sql-server-native-client?view=sql-server-ver16
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Configure. If an appropriately named DSN does not already exist, click Add to create a 
new one. 

3. Select the driver name that is appropriate for your database from the list. For PostgreSQL, 
select PostgreSQL Unicode (x64).  

 
4. Click Finish to create the connection. 

5. The PostgreSQL dialog box displays. 

 
6. Type the DSN name that you provided in the SAS Deployment Wizard for SAS Cost and 

Profitability Management.  

7. Type a description of this data source in the Description field. SAS suggests using 
“Connection to the SAS CPM database” as the description. Specify abmmodels as the 
database name.  

8. Type the Server, Port, User and Password for the SAS Cost and Profitability Management 
Models Database. Refer to the table that you completed in Chapter 5 for port information. 

9. Click Test to verify the information that you supplied. The connection to the SAS Cost and 
Profitability Management database is tested.  

10. Click OK to complete DSN creation. 
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Oracle 
Take the following steps to create DSNs in an Oracle deployment: 

1. From the Control Panel, open Administrative Tools→Data Sources. 

2. Click the System DSN tab. If a DSN exists with the data source name that you entered in 
the SAS Deployment Wizard, edit it by selecting the DSN name in the list and clicking 
Configure. If an appropriately named DSN does not already exist, click Add to create a 
new one. 

3. Select the driver name that is appropriate for your database from the list. For Oracle, select 
Oracle in <MyOracleHomeName>, where MyOracleHomeName is the home name that you 
provided when you installed the Oracle database.  

4. Click Finish to create the connection. 

 
5. The Oracle ODBC Driver Connection dialog box opens. Type the Data Source Name that 

you supplied to the SAS Deployment Wizard. Enter a description of this data source into 
the Description field. SAS suggests using “Connection to the SAS CPM database” as the 
description.  

6. In the TNS Service Name field, type the Net Service Name that you created, as described 
in the section titled “Oracle Net Configuration” in Appendix B.  

 
7. In the User ID field, type the SAS Cost and Profitability Management user/schema that 

you created as part of your Oracle database installation. Refer to the table that you 
completed in Chapter 5 for more information.  

8. Click Test Connection to verify the configuration.  
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9. Click OK when you have completed these steps. 

Configuring ODBC Data Sources on UNIX 
For more information about ODBC data sources, see “Appendix F – ODBC Data Sources on 
Linux.” Also see the instructions for your operating system for the exact steps. 

Configuring Integrated Windows Authentication (IWA)  
If your deployment is IWA-enabled, perform following steps. If you are not doing an IWA 
deployment, you can skip these steps. 

1. On the Windows machine where you are performing the deployment, edit the file 
wrapper.conf in the following directory:  

SASCONFIG\Lev1\Web\WebAppServer\SASServer9_1\conf.  

2. Add the following Java argument:  
java.security.krb5.conf 

3. Set it to point to the correct krb5 file. For example:  
wrapper.java.additional.51 = -Djava.security.krb5.conf = 
“C:/SAS/Config/Lev1/Web/WebAppServer/SASServer1_1/conf/krb5.ini” 

Make sure you are specifying forward slashes in the path.  

SAS OLAP Setup 
1. Open SAS Management Console using an account with administrator privileges. Open the 

User Manager. 

2. Open the Properties dialog box for the Cost and Profitability Management Server Users 
group.  

3. Click the Accounts tab. You should see a user for the C&PM IOM server (for example, 
iomuser). 

4. Select the row and click Edit.  

5. Change the Authentication Domain for the user to any other name (for example, 
CPMIOM). 

6. Save changes.  

7. Restart the ObjectSpawner and SASServer9_1 services. 

SSAS Setup 
1. Repeat all the steps listed above for SAS OLAP Setup until you reach Step 7. Do not restart 

the Object Spawner or SASServer9_1 services yet. 

2. Open the Properties dialog box for the Cost and Profitability Management Users group.  

3. Click the Accounts tab. 

You will see two users. One is defined in the ABMDB domain, and the other in the 
DefaultAuth domain. (The second user is the network user, for connecting to Microsoft 
Analysis Services.)  

4. Change the domain of the DefaultAuth user to any other name (for example, CPMSSAS). 
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5. Open the SAS CPM Software Component Properties dialog box by clicking Configuration 
Manager -→ SAS Application Infrastructure → Cost and Profitability Mgmt 8.4. 

6. Click the Advanced tab.  

7. Change the value of the “data.abmserver.ssas.authdomain.name” property to the name 
that you used in Step 4 (for example, CPMSSAS). 

8. Save your changes. 

9. Restart the ObjectSpawner and SASServer9_1 services. 

Oracle Bulk Data Loader 
If you are using an Oracle database, the Model Server uses the Oracle bulk data loader to improve 
performance when loading and saving data. Verify that the Oracle bulk data loader, named 
sqlldr.exe on Windows systems and sqlldr on UNIX systems, is included in the PATH 
environment variable so that SAS Cost and Profitability Management Model Server can invoke it. 

Note:  If Oracle12c client is used, place the oraodm12.dll at the following location:  

ORACLE_HOME/client/bin  

This location enables sqlldr to run properly. 

PostgreSQL Bulk Data Loader 
If you are using PostgreSQL database, the Model Server uses the PostgreSQL bulk loader to 
improve performance when loading and saving data. The below instructions need to be followed 
to configure the bulk insert. 

UNIX 
1. Stop the SAS Object Spawner and make sure all the abmx processes are closed/killed. 

2. Edit /SASConfig/Lev1/SASApp/ABMServer/config/settings.xml to add the PSQL 
path. Here is an example: 
<BulkPathPostgres>PSQL-Path</BulkPathPostgres> 

 
Note: The PSQL is already deployed with SASWebInfrastructurePlatformDataServer. Verify the 

location of PSQL in the Compute tier. That location should be specified for 
<BulkPathPostgres>. 

3. Create the file /SASConfig/Lev1/SASApp/ABMServer/config/.pgpass to store the 
database password. If the passwords are different for different database users, specify 
them on new lines, as shown below: 

 
4. Give the Cost and Profitability Management Server user Read/Write permissions to the 

.pgpass file: 

o Log in to the SAS Management Console.  
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o Access the Cost and Profitability Management Server Users group from the User 
Manager. 

o Go to Properties and click the Accounts tab. 

 
In this example, iomuser is the Cost and Profitability Management Server user. If you 
assigned this account a different name, the user that is shown on the Accounts tab 
should be the owner of the .pgpass file. 

Assign ownership for the iomuser using the following command: 

chown iomuser  

Assign Read/Write permissions:  

chmod 0600. 

 
5. Start SAS Object Spawner. 

Windows 
1. Stop the SAS Object Spawner and make sure all the abmx processes are stopped or killed. 

2. Edit CONFIGHOME\SASApp\ABMServer\config\settings.xml to add the PSQL path. 
Here is an example:  
<BulkPathPostgres>PSQL-Path</BulkPathPostgres> 

 
Note: The PSQL component is already deployed with SAS Web Infrastructure Platform Data 

Server. Verify the location where PSQL is installed in the Compute tier. Specify that 
location for <BulkPathPostgres>. 

If the names of PSQL path folders contain spaces, specify their short names. For example, 
Progra~1 is the short name for the Program Files folder. 
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3. Create the file CONFIGHOME\SASApp\ABMServer\config\pgpass.conf in order to store 
the database password. If the passwords are different for different database users, specify 
them on new lines as shown in the following example:  

 
4. Give the Cost and Profitability Management Server user Read/Write permissions to the 

.pgpass file: 

o Log in to the SAS Management Console.  
o Access the Cost and Profitability Management Server Users group from the User 

Manager. 
o Go to Properties and click the Accounts tab. 

 
In this example, iomuser is the Cost and Profitability Management Server user. If you 
assigned this account a different name, the user that is shown on the Accounts tab 
should be the owner of the .pgpass file. 

Assign Read/Write permissions for the iomuser. 

5. Start SAS Object Spawner. 

Note:  All the internal errors that are thrown or handled by the PSQL utility are logged separately 
into CONFIGHOME\SASApp\ABMServer\temp\psqlbulk.log. Check this file for 
errors associated with any failures. 

Importing and Exporting Model Data 
SAS Cost and Profitability Management can import and export model data from or to any data 
source. 

For Microsoft SQL Server, Oracle, and PostgreSQL databases, SAS Cost and Profitability 
Management requires the database connection details to connect to the database.  

For any other database, SAS Cost and Profitability Management can make a connection through 
ODBC. To enable this configuration, appropriate DSNs must first be created on the Model Server. 

If your setup is SSL-enabled, and if the C&PM client machine has Internet Explorer 10, you might 
need to explicitly enable the TLS 1.2 option in the Internet Explorer Advanced settings. If this 
setting is not enabled, the Import operation might fail. 
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Importing and Exporting Data from Microsoft Office Applications 
SAS Cost and Profitability Management supports importing data from and exporting data to 
Microsoft Office applications. As noted above, to perform these tasks, data access drivers are 
required. For Microsoft Office, install the Office ODBC drivers that are compatible with your 
version of Microsoft Office. Although 32-bit and 64-bit versions of these drivers are available, you 
must install the 32-bit versions; the SAS Cost and Profitability Management client application can 
only access 32-bit drivers. 

Note: In previous versions of SAS Activity-Based Management, Microsoft Office files were imported 
from the Server, and therefore the Office ODBC drivers had to be installed there. Microsoft no 
longer supports Office drivers on a server operating system or on a computer that is used as a 
server in a deployment architecture, regardless of its operating system. Therefore, SAS has 
changed the SAS Cost and Profitability Management Office Import feature to work from the 
Client computer, not from the Server computer. 

Whether you use 32-bit drivers or 64-bit drivers to access your Office files, the same size 
limitations apply. With a 64-bit version of Office (either 2013 or 2016) on your client, you may not 
be able to install a 32-bit driver for Microsoft Office. But you can install the 32-bit drivers for 
another version of Office. For example, if you have a 64-bit version of Office 2016 and cannot 
install the 32-bit version of the Office 2016 drivers, you can install the 32-bit versions of the Office 
2013 drivers, and all will function correctly. 

Note: Be sure to install the 32-bit versions of the Microsoft Office drivers. 

Configuring OLAP Permissions 
SAS OLAP Server uses operating system authentication to manage access to cubes. Thus, SAS 
requires each user of SAS Cost and Profitability Management to have access to the directory where 
SAS OLAP cubes are created. Any user who wants to create or delete OLAP cubes must have 
sufficient privileges on that folder and cube file. Any user who wants to view cubes requires read 
privileges on that cube. These privileges are granted by the host operating system and are not 
managed by the SAS Metadata Server. 

Tip Using operating system groups can simplify user management. 

Windows 
Take the following steps to configure OLAP permissions in a Windows environment: 

1. Open Windows Explorer on the SAS Cost and Profitability Management OLAP Server and 
browse to the directory where SAS OLAP cubes are created:  

CONFIGHOME\AppData\SASCostAndProfitabilityManagement\cubes 

Create this directory if it does not already exist. 

2. Right-click the cubes directory, and select Properties. 

3. The Properties dialog box opens. Click the Security tab. 

4. Verify that each SAS Cost and Profitability Management user who creates cubes has 
Modify, Read, and Write access to the directory. When you select Modify, the Read & 
Execute and List Folder Contents privileges are also selected.  

5. Make sure that each SAS Cost and Profitability Management user who views cubes has 
Read access to the directory. 
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or 

 

6. Finally, make sure that each user who creates SAS OLAP cubes has permission to Log on 
as a batch job.  

Note:  This setting was configured in Chapter 5 when you created the SAS Server Users group.  

UNIX 
Take the following steps to configure OLAP permissions in a UNIX environment: 

1. Navigate to the directory where SAS OLAP cubes are created on the SAS Cost and 
Profitability Management OLAP Server: 
CONFIGHOME/AppData/SASCostAndProfitabilityManagement/cubes.  

Create this directory if it does not already exist. 

2. Make sure each SAS Cost and Profitability Management user who creates cubes has Read, 
Write, and Execute access to the directory. Also make sure each SAS Cost and Profitability 
Management user who views cubes has Read access to the directory 

3. Each user who creates SAS OLAP cubes must be part of the SAS Server Users group. Refer 
to Chapter 5, where you set up the SAS Server Users group. 

4. Execute the following command to change permission on the directory:  
chmod -R 775 CONFIGHOME/AppData/SASCostAndProfitabilityManagement/cubes 

5. Finally, the default security setting for files created is 755 or lower, so add umask 002 to 
the appservercontext_env_usermods.sh file that launches the SAS Workspace Server on 
your OLAP Server. Files that are created in the cubes folder will then have the proper 
permissions. 

MSAS/SSAS Configuration 
Additional settings are required if you are using Microsoft SQL Server Analysis Services to 
generate cubes. You must modify two configuration files. 

The files named ABMServer.exe.config and 
sas.activitybasedmanagementsvr.service.exe.config are located in the following 
directory:  

SASHOME\SASCostandProfitabilityManagementMidTier\8.4\bin. These files should 
contain the following entries:  

• For Analysis Services 2012: 
<bindingRedirect oldVersion=”9.0.242.0” newVersion=”11.0.0.0”/> 

• For Analysis Services 2014: 
<bindingRedirect oldVersion=”9.0.242.0” newVersion=”12.0.0.0”/> 

• For Analysis Services 2016: 
<bindingRedirect oldVersion=”9.0.242.0” newVersion=”13.0.0.0”/> 
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• For Analysis Services 2017: 
<bindingRedirect oldVersion=”9.0.242.0” newVersion=”14.0.0.0”/> 

• For Analysis Services 2019: 
<bindingRedirect oldVersion=”9.0.242.0” newVersion=”15.0.0.0”/> 

• For Analysis Services 2022: 
<bindingRedirect oldVersion=”9.0.242.0” newVersion=”15.0.0.0”/> 

SAS OLAP Configuration 
Additional settings are required if you have an internationalized deployment, where non-English 
characters are part of the model data and the database that is used is either Oracle or PostgreSQL. 

To set these additional properties, take the following steps: 

1. In SAS Management Console, open Data Library Manager → Libraries → CPM Library.  

2. Open the Properties dialog box, and click the Options tab. 

3. Click Advanced Options. 

4. Click the Output tab. Set Preserve column names as in the DBMS to Yes. 

5. Click the Input/Output tab. Set Preserve DBMS table names to Yes. 

6. Click Ok to save your changes. 

Cube Generation in a Localized Environment 
The SAS OLAP cube generation might fail on localized environments, such as zh, zt, ja, ko. In that 
case, you must use your preferred text editor to modify the file C:\Program 
Files\SASHome\SASFoundation\9.4\nls\locale\sasv9.cfg. Replace locale with the 
relevant locale. Add the following lines to it.  

-VALIDVARNAME ANY 

-VALIDMEMNAME EXTEND 

You must restart SAS services after this change.  

Windows Services 
In Windows installations that are using Microsoft SQL Server Analysis Services for OLAP, the 
deployment process provides an option to launch some processes manually or to use management 
scripts to run them. This section explains how to launch SAS Cost and Profitability Management 
processes if you did not select Run as Windows Services. 

If you are using Microsoft SQL Server Analysis Services, an ABMServer process handles 
communications between the Java-based process on the Middle-Tier Server and the .NET-based 
processes on the OLAP Server (which in this specific case is a Windows computer using Microsoft 
SQL Server Analysis Services). If you elected not to run this process as a service, you must run it 
under a user account. The user that runs the ABMServer process must have sufficient privileges to 
impersonate the cube creation user that you provided in the Microsoft SQL Server Analysis 
Services wizard on your OLAP Server. Typically, this user must be a member of the Power Users 
group on the Middle-Tier Server. 

You must manually restart this process each time you restart or log out of the Middle-Tier Server. 
To launch the ABMServer process manually: 
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1. Open Windows Explorer on the SAS Cost and Profitability Management Middle-Tier Server 
and browse to the folder at 
SASHOME\SASCostAndProfitabilityManagementMidTier\8.4\bin. 

2. Right-click ABMServer.exe and select Run as. 

3. Select to run it as the Current user (if the user has sufficient privileges), or click the 
following user and specify a username and password.  

4. Click OK. 

Do not log off the computer. If you do, this process will stop running and your SAS Cost and 
Profitability Management server will not properly create cubes. 

Post-Migration Steps for In-Place Migration 
This section describes the steps to migrate database models from version 7.x to SAS Cost and 
Profitability Management 8.4M2 for an in-place migration. For all other types of migration, skip 
this section. 

Model Migration Utility 
After an in-place data migration, you must run the SAS Model Migration utility on the Model 
Server. This utility reads the models that are stored in the relational database and creates model 
files on disk that are optimized for fast loading into memory.  

Important:  To run the Model Migration Utility on Linux, you must use the same external user 
credentials that you specified in SDW for Model Server. This user will later be used to access 
and modify model files on disk. Using a different user to run Model Migration Utility may 
cause file permission issues and the product may not function properly.  

On the Model Sever, open a command prompt and change the directory to 
SASHOME/SASFoundation/9.4/abmiomsvr/sasexe. Then run the following command: 

Windows: 
AbmDbToMdl.exe DSN DBUSER DBPWD DBTYPE MDLFOLDER CONFIGFOLDER > 
AbmDbToMdl.log 

Linux: 
export LD_LIBRARY_PATH=SASHOME/SASFoundation/9.4/abmiomsvr/sasexe:$ 
LD_LIBRARY_PATH 

AbmDbToMdl DSN DBUSER DBPWD DBTYPE MDLFOLDER CONFIGFOLDER > 
AbmDbToMdl.log 

Substitute the following information for the variables (shown in italics): 

DSN: The ODBC data source that is pointing to relational database used by Cost and Profitability 
Management. It should be pre-created on the Model Server with the same name as specified at the 
installation time.  

DBUSER: A user (or schema) to connect to the SAS Cost and Profitability Management database. 

DBPWD: The password for the user. 

DBTYPE: The database type. Specify 1 for Microsoft SQL Server and 2 for Oracle. 

MDLFOLDER: The directory location where SAS Cost and Profitability Management models will 
be stored on the Model Server. The default location is CONFIGHOME\SASApp\ABMServer\Models. 
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CONFIGFOLDER: The location of the Configuration file. Specify 
CONFIGHOME\SASApp\ABMServer\config 

Here is an example of a Model Migration utility command for Microsoft SQL Server on Windows: 
AbmDbToMdl.exe ABMDSN_Lev1 sascpmuser pwd 1 
C:\SAS\Config\Lev1\SASApp\ABMServer\Models 
“C:\SAS\Config\Lev1\SASApp\ABMServer\config” > AbmDbToMdl.log 

Here is another example for Oracle on Linux: 
./AbmDbToMdl ABMDSN_Lev1 sascpmuser pwd 2 
/install/SAS/Config/Lev1/SASApp/ABMServer/Models 
/install/SAS/Config/Lev1/SASApp/ABMServer/config > AbmDbToMdl.log 

Important:  SAS Cost and Profitability Management 8.4 enforces business rules more rigidly than the 
previous versions of SAS Activity-Based Management. Some models may fail to completely 
migrate with the Model Migration Utility. The migration utility provides warnings or 
errors in those cases. You will then need to export the affected models from the old version 
of the software and replace the partially migrated models in SAS Cost and Profitability 
Management 8.4M2 by importing them. 

Delete Old SAS OLAP Cubes from SAS Metadata Server 
If you were using SAS OLAP Server with your previous version of SAS Activity-Based 
Management, you must delete old cubes. This requirement is caused by changes in physical 
directory names in SAS Cost and Profitability Management 8.4. If you were using Microsoft 
Analysis Services with your previous version of SAS Activity-Based Management, this section 
does not apply to you.  

To delete cubes, take the following steps: 

1. Open SAS Management Console and log in as a user with cube creation privileges.  

2. Click the Folders tab and expand Products → SAS Cost and Profitability Management.  

Click the Cubes folder. The right pane lists old cubes: 

 
3. Select all cubes (or repeat the steps for each cube) and press Delete.  

You are prompted to confirm the deletion.  

When prompted for the “Default Application Server,” select the application server that is 
configured for the SAS OLAP Server, and click OK.  

You might also see warnings or errors in the SAS log stating that the old physical path is not 
found. Such messages reflect the fact that the old path does not exist and can safely be ignored. 
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Update Cube Configurations 
If you were using SAS OLAP Server with your version of SAS Activity-Based Management 7.x, 
you must update cube configuration that was created with this solution. This requirement is due 
to changes in SAS Metadata folder names in SAS Cost and Profitability Management 8.4. If you 
were using Microsoft Analysis Services with SAS Activity-Based Management, this section does 
not apply to you.  

To update cube configuration, take the following steps: 

1. Log in to SAS Cost and Profitability Management client. 

2. Click on the Cube Configuration workspace folder.  

3. Edit each configuration in the right pane and update the metadata folder path. Change it 
from /Products/SASActivityBasedManagement/Cubes  
to /Products/SASCostAndProfitabilityManagement/Cubes. 

Or you can remove old cube configurations and create new ones for each model. Contact SAS 
Technical Support if you have any issues.  

Warning:  Attempting to generate cubes from old cube configurations without updating them produces 
errors because the old metadata folder path does not exist in SAS Cost and Profitability 
Management 8.4. 

Data Import and Export Configurations 
SAS Cost and Profitability Management 8.4 uses SAS drivers to connect to relational databases 
using ODBC. SAS Activity-Based Management 7.x used JDBC for database connections. As a 
result of this change, you must recreate the data sources for model data import and export 
configurations. You can update a data source by opening each configuration, which launches a 
wizard, and re-attaching to your data source using one of several available methods. 

 
For more information about the available options when creating data sources, see the topic 
“Connect to a Database” in the SAS Cost and Profitability Management 8.4 online Help. 

Creating SAS Cost and Profitability Management Users 
Each SAS Cost and Profitability Management user requires an account in SAS Metadata server. 
Before you run SAS Cost and Profitability Management, you must create at least one user. Add a 
single user now, or add all users. For information on adding users, see the SAS 9.4 Intelligence 
Platform Installation and Configuration Guide. 

https://go.documentation.sas.com/doc/en/bicdc/9.4/biig/p02intellplatform00installgd.htm
https://go.documentation.sas.com/doc/en/bicdc/9.4/biig/p02intellplatform00installgd.htm
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Once you have at least one SAS Cost and Profitability Management user in SAS Metadata server, 
you can create the necessary group(s) and role(s) to manage authorized users. Each authorized 
user can have unique feature access privileges, or capabilities, in SAS Cost and Profitability 
Management. Each user who wants to run SAS Cost and Profitability Management requires three 
items in SAS Metadata Server: 

• an internal user account (on the Metadata Server) 
• a role that provides at least one SAS Cost and Profitability Management capability 
• membership in the “Cost and Profitability Management Users” group 
We will walk through an example that creates a role for the users who have full access to the 
model-building features of SAS Cost and Profitability Management, the Create Models capability. 
For more information about user capabilities, see “User Capabilities and Groups” in the SAS Cost 
and Profitability Management Client Help. 

Tip:  If you are not ready to add your SAS Cost and Profitability Management users to the Metadata 
Server, you may use your SAS First User account instead. 

Configuration-Created Metadata 
The SAS Cost and Profitability Management configuration process creates three user roles, six 
groups, and one library in the SAS Metadata Server.  

The SAS Cost and Profitability Management roles are as follows: 

• Cost and Profitability Management: Administration 
• Cost and Profitability Management: Create Models 
• Cost and Profitability Management: View Models 
These roles are predefined to provide a common set of capabilities for you to use when 
configuring your installation. You may create as many additional roles as needed to customize 
your deployment. 

The predefined groups are as follows: 

• Cost and Profitability Management Users (an “umbrella” group for all Cost and Profitability 
Management users) 

• Cost and Profitability Management Cube Creators (for SAS OLAP users who create cubes) 
• Cost and Profitability Management Viewers 
• Cost and Profitability Management Modelers 
• Cost and Profitability Management Administrators 
• Cost and Profitability Management Server Users 
The first group, “Cost and Profitability Management Users” contains all the users who are 
authorized to use the SAS Cost and Profitability Management product. The users in this groups 
are added either directly as users or indirectly, through their membership in other groups. 

The second group, “Cost and Profitability Management Cube Creators”, contains all the users who 
will create SAS OLAP Server cubes. Users who have the Create Models and Create Cubes 
capabilities must belong to this group. If you are not using SAS OLAP Server to create your cubes, 
you may ignore this group. 

The “Cost and Profitability Management Modelers” group needs to be added in the authorization 
tab for the folder “Registered Tables and Views”. This enables the users from this group to register 
the reports in metadata. 
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The remaining groups are predefined to provide a common placeholder for users when you 
configure your installation. You may create as many additional groups as required to customize 
your deployment. 

Tip:  SAS recommends that roles contain an active name. For example: “Cost and Profitability 
Management: View Models,” or “Cost and Profitability Management: Administration” are useful 
names. The product name should prefix the active name with a colon separator. This helps manage 
the diverse products, capabilities, and users in your SAS Metadata Server by partitioning them 
logically. In addition, SAS recommends that groups contain a user’s activity. For example, “Cost 
and Profitability Management Administrators” without a colon separator clarifies the group’s 
purpose. 

The predefined library is named CPM Library. 

The “CPM Library” library reference in the Data Library Manager is used by the SAS OLAP 
Server to store information about your cubes. 

Creating a SAS Cost and Profitability Management Role 
Take the following steps to create a new user role: 

1. Open the SAS Management Console using a SAS administrative user. 

2. Click the Plug-ins tab and select the Foundation repository.  

3. Expand the Environment Management folder. A role named “Cost and Profitability 
Management: Create Models” should already be present. If it is not present, create it. 

a. Right-click the User Manager and select New→Role. 

b. Add a Name for the role. SAS recommends using “ABM: Create Models” with a 
Display Name of “Cost and Profitability Management: Create Models” as the role 
name. 

4. Select the Capabilities tab, and expand the Activity-Based Mgmt 8.4 folder 

5. Check the Create Models capability. 

6. Click OK to save the role. 

7. Repeat these steps for the View Models and Administration roles. 

Creating a SAS Cost and Profitability Management Group 
Now create a group to hold all the users who will have the SAS Cost and Profitability 
Management Create Models capability. Take the following steps: 

1. Open the SAS Management Console using a SAS administrative user. 

2. Click the Plug-ins tab at the top and select the Foundation repository.  

3. Expand the Environment Management folder. If you do not see a group named “Cost and 
Profitability Management Modelers,” create one. Or create a custom group: 

a. Right-click the User Manager and select New→Group. 

b. Add a Name for the group. SAS recommends using “CPM Modelers” with a 
Display Name of “Cost and Profitability Management Modelers” for the group 
name. 

4. Add the Create Models role to this group: 
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a. Select the Groups and Roles tab. 

b. Add the Create Models role by moving it from the Available Groups and Roles list 
to the Member of list. 

5. Add the SAS Cost and Profitability Management users who require this set of capabilities:  

a. Click the Members tab. 

b. Add the desired users to this group by moving them from the Available Identities 
left-hand list to the Current Members right-hand list. 

6. Click OK to save the group. 

7. Repeat the previous steps for the “Cost and Profitability Management Viewers” and 
“Administrators” groups, replacing the linked role with the role that you created for each 
group. 

Adding a Group to the Cost and Profitability Management Users Group 
The new groups that you create must be members of the main Users group so that they can access 
the SAS Cost and Profitability Management software. Take the following steps to add a group to 
the Users group: 

1. Open the SAS Management Console using a SAS administrative user. 

2. Click the Plug-ins tab and select the Foundation repository.  

3. Expand the Environment Management folder. 

4. Select the User Manager folder. 

5. Select the group “Cost and Profitability Management Users” and view its properties. 

6. Click the Members tab. 

7. Add all the groups that you have created to this group. The steps are similar to those that 
are described in Creating a SAS Cost and Profitability Management Group 58on page 58. 

8. Click OK to save the group. 

Here is a summary of the steps that are required in order to enable users to run SAS Cost and 
Profitability Management with the capabilities that they require. We performed four basic steps: 

1. We created a role with the desired capability. 

2. We created a group and added the new role to it so that all the users in that group can 
access those capabilities. 

3. We added all the SAS Cost and Profitability Management users who require this set of 
capabilities to the group. 

4. We added this new group to the “Cost and Profitability Management Users” group so that 
these users can run the SAS Cost and Profitability Management software. 

If this deployment is using SAS OLAP Server to create cubes, you must also add the “Create 
Models” group to the “Cube Creators” group so that users can build SAS OLAP cubes. 
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Setting Up Users for Mixed-Architecture Environments 
If you use both Windows and UNIX servers in your SAS Cost and Profitability Management 
deployment, verify that the SAS Cost and Profitability Management users have logins for both 
machines. The authentication domains are defined when you create the servers in metadata. 

 

Setting Up Users for Integrated Windows Authentication 
If your deployment is IWA-enabled, and if the SAS Server Tier is running on Windows, you will 
need two accounts for each user in metadata, as shown below: 

 
For Linux, define the user name with a single account and without the domain name. 

Validating the SAS Cost and Profitability Management Solution 
SAS Cost and Profitability Management ships with client diagnostics. It is installed on the Client.  

Client Diagnostics Utility 
The client diagnostic application is available from the Start menu at All Programs→SAS→SAS 
Cost and Profitability Management 8.4→Tools→SAS Cost and Profitability Management 
Client Diagnostic. The client diagnostic tool validates many aspects of the SAS Cost and 
Profitability Management client installation. Verify that all tests pass successfully. They execute 
very quickly and take only a few seconds to run. 

The client diagnostic application also provides a System Information report that provides 
deployment and version information. The System Information report must run as an authorized 
SAS Cost and Profitability Management user. You are prompted to log in when you run it. 

Note:  On some machines, a blank page might be displayed for the System Information report. If 
you encounter this issue, copy the file Microsoft.mshtml.dll to the Cost and Profitability 
Management client folder, which is typically 
\SASHome\x86\SASCostandProfitabilityManagementClient\8.4\bin. This 
DLL is found in Windows system folders. 
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Appendix  A – Third-Party Migration 
This appendix describes migrating third-party software from SAS Activity-Based Management 7.x 
versions to the present version of SAS Cost and Profitability Management. 

Migrating from SAS OLAP Server 9.2 or 9.3 
If you did not use SAS OLAP Server to build your cubes with SAS Activity-Based Management 7.x 
you can skip this section.  

When SAS Activity-Based Management built cubes with SAS OLAP Server 9.2 or 9.3, it created two 
types of data. The first is the operating system file representing the physical cubes themselves and the 
second is the metadata content about these cubes in the SAS Metadata Server.  

Deleting SAS OLAP Metadata 
The cubes and information maps created by the SAS OLAP Server are located in the SAS Metadata 
Console with other cubes. They must be deleted as part of the migration. 

To delete the OLAP metadata: 

1. Open the SAS Metadata Console application. 

2. Select the Foundation repository in the Repository list. 

3. Expand the Environment Management folder. 

4. Expand the Authorization Manager folder. 

5. Expand the Resource Management folder. 

6. Expand the By Type folder. 

7. Expand the Cube folder.  

All the cubes that were created by SAS Activity-Based Management have a name in the format 
MXXXX_SomeName, where XXXX is a number from 1000 onwards.  
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8. Open a Base SAS session by selecting All Programs → SAS → SAS 9.4. 

9. Paste the following code into the Editor window, replacing the items in italics with 
information that applies to your deployment:  
PROC OLAP cube=MyCubeName DELETE; 

METASVR host=”MyMetadataServer” port=8561 protocol=bridge 
userid=”MyAdminUser” 

              pw=”MyAdminPassword”  

              repository=”Foundation” 

              olap_schema=”MyOlapSchemaName”; 

           RUN; 

Where:  

MyCubeName is the name of each cube listed in the Metadata Server. 

MyMetadataServer is the name of the computer hosting your SAS Metadata Server. 

MyAdmin… is the administrative username and password that you provided to the SAS 
Activity-Based Management 7.x. 

MyOlapSchemaName is the schema name that you provided to the SAS Activity-Based 
Management 7.x. 

10. Click Submit to execute the code. Repeat for each SAS Activity-Based Management cube that 
is defined in your metadata. This process also deletes the physical cube, if it exists, so you can 
skip the next section. 
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Deleting SAS OLAP Cubes 
The OLAP cubes are stored as files on the operating system. Simply deleting the files will also delete 
the cubes. The cubes are stored in the directory that you specified when you selected the directory that 
you specified in the SAS Deployment Wizard while configuring the SAS OLAP Server (if you are 
migrating from SAS Activity-Based Management 7.x). By default, this directory is at: 
C:\SAS\Config\Lev1\AppData\SASCostAndProfitabilityManagementx.x\cubes where 
x.x represents the version of SAS Activity-Based Management that you are migrating.  

Rebuilding SAS OLAP Cubes 
After completing the SAS Cost and Profitability Management installation, rebuild the SAS OLAP 
Server cubes using SAS Cost and Profitability Management 8.4.  

Migrating Cubes 
At this point in the migration, you have cleaned up the physical cubes and, if using SAS OLAP, any of 
the metadata for those cubes as well. 

However, SAS Cost and Profitability Management also stores a small amount of data about the cubes 
that are available for viewing. This data must also be removed. This step is not performed 
automatically as part of the database upgrade process (Chapter 9). Instead, you must manually run 
two queries from your database management application. 

Tip: When you recreate your cubes using SAS Cost and Profitability Management 8.4, your saved OLAP 
Views will automatically access the new cubes. 

Microsoft SQL Server  
Follow the relevant Microsoft documentation in order to remove data that corresponds to old cubes. 

Oracle  
Follow the relevant Oracle documentation to execute the required queries in order to delete old cube 
data.  
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Appendix B– Debug Configuration Guide 
This appendix discusses how to change logging properties. This advanced topic is typically used with 
the guidance of SAS Technical Support to monitor your SAS Cost and Profitability Management 
installation. 

Logging 
SAS Cost and Profitability Management 8.4 provides logging for the server applications.  

Model Server Logging 
Model server logging is controlled by the ABMLogConfig.xml file in your configuration directory: 

Windows:  CONFIGHOME\SASApp\ABMServer\config 

UNIX:   CONFIGHOME/SASApp/ABMServer/config 

The log file AbmLog_MmodelID.log is stored in the configuration directory that you selected.  

Windows:  CONFIGHOME\SASApp\ABMServer\Logs 

UNIX:   CONFIGHOME/SASApp/ABMServer/Logs 

Default logging categories that are provided with the deployment are as follows: 

<logger name=”com.sas.solutions.abm.mdlsvr.model”> 
<logger name=”com.sas.solutions.abm.mdlsvr.storage”> 

Different logical categories for the logging are as follows:  
<logger name=”com.sas.solutions.abm.mdlsvr.model”> 
<logger name=”com.sas.solutions.abm.mdlsvr.storage”> 
<logger name=”com.sas.solutions.abm.mdlsvr.oroscmd”> 
<logger name=”com.sas.solutions.abm.mdlsvr.database”> 
<logger name=”com.sas.solutions.abm.mdlsvr.rdbms”> 
<logger name=”com.sas.solutions.abm.mdlsvr.operation”> 
<logger name=”com.sas.solutions.abm.mdlsvr.equation”> 
<logger name=”com.sas.solutions.abm.mdlsvr.biztier”> 
<logger name=”com.sas.solutions.abm.mdlsvr.iom”> 

If logging is required for other logical areas, you can add entries to the ABMLogConfig.xml file. 
Here is an example: 

     <logger name=”com.sas.solutions.abm.mdlsvr.operation” additivity=”false”> 
 <level value=”INFO” /> 
 <appender-ref ref=”filer” /> 

</logger> 

The different logging levels are as follows: 

INFO – The default logging level. Provides information messages. 

WARN – Logs warning messages. 

ERROR – Logs any errors encountered while executing. 
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DEBUG – The detailed logging level, which provides debug information. Use it only when 
debugging an issue because it might create a large log file. 

For detailed logging, set DEBUG under the respective category in the ABMLogConfig.xml file. 

Here is an example: 

<logger name=”com.sas.solutions.abm.mdlsvr.model” additivity=”false”> 
 <level value=”DEBUG” /> 
 <appender-ref ref=”filer” /> 
</logger> 

Mid-Tier Logging 
Mid-tier logging is controlled by the SASCostAndProfitabilityManagement-log4j.xml file in 
your configuration directory. 

Windows:  CONFIGHOME\Web\Common\LogConfig 

UNIX:   CONFIGHOME/Web/Common/LogConfig 

The log file name is SASCostAndProfitabilityManagement8.4.log, and it is created in your 
configuration directory.  

Windows:  CONFIGHOME\Web\Logs 

UNIX:   CONFIGHOME/Web/Logs 

Different logical categories for the SAS Cost and Profitability Management logging are as follows:  
<category name=”com.sas.solutions.abm.server.webservices”> 
<category name=”com.sas.solutions.abm.server.bt”> 
<category name=”com.sas.solutions.abm.server.core”> 
<category name=”com.sas.solutions.abm.server.db”> 
<category name=”com.sas.solutions.abm.server.common”> 
<category name=”com.sas.solutions.abm.server.webservices.webappcore”> 

The different logging levels are as follows: 

INFO – This is the default logging level. It provides information messages. 

WARN – This will log the warning messages. 

ERROR – This will log the errors encountered while executing. 

DEBUG – The detailed logging level, which provides debug information. Use it only when 
debugging an issue because it might create a large log file. 

For detailed logging, set DEBUG under the respective categories in the log4J.xml file. 

Here is an example: 

  <category additivity=”false” name=”com.sas.solutions.abm.server.webservices”> 
  <priority value=”DEBUG” /> 
 <appender-ref ref=”SAS_FILE” /> 
  </category> 
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Appendix C – Model Backup and Restore 
This appendix details the backup and restore process for SAS Cost and Profitability Management 
models.  

In all versions of SAS Activity-Based Management, the models were stored inside a relational 
database. In version 8.4, models are now stored in a file on disk on the Model Server and are optimized 
for fast loading into computer memory. It is very important to back up SAS Cost and Profitability 
Management models on a regular basis to recover from any catastrophic error.  

Important:  To run the Model Backup and Restore Utility on Linux, you must use the same external user 
credentials that you specified in SDW for Model Server.  

No model should be open in either Read or Write mode while running Model Backup and Restore. 
Either the model user or an administrator can release locks on the models from the SAS Cost and 
Profitability Management client. 

To back up SAS Cost and Profitability Management models, take the following steps on the Model 
Server. 

1. Make sure all users have logged out of SAS Cost and Profitability Management. 

2. Stop the SAS Object Spawner. 

3. Open a command window. 

4. Change the directory to  

SASHOME\SASFoundation\9.4\abmiomsvr\sasexe (Windows) or 
SASHOME/SASFoundation/9.4/sasexe (Linux). 

5. Run the following command: 

Windows:  
AbmMdlMigration.exe -backup -src=MDLFOLDER -dst=BACKUPFOLDER  
-appcfg=CONFIGFOLDER > backup.log 

Linux:  
export LD_LIBRARY_PATH=<SASHOME>/SASFoundation/9.4 
/sasexe:$LD_LIBRARY_PATH./AbmMdlMigration -backup -src=MDLFOLDER  
-dst=BACKUPFOLDER -appcfg=CONFIGFOLDER > backup.log 

Where: 

MDLFOLDER: Specifies the directory where SAS Cost and Profitability Management models 
will be stored on the Model Server. The default location is 
CONFIGHOME\SASApp\ABMServer\Models. 

BACKUPFOLDER: Specifies the folder where you want to back up SAS Cost and Profitability 
Management models. Verify that the specified folder exists and is empty.  

CONFIGFOLDER: Specifies the configuration folder for SAS Cost and Profitability 
Management solution. The default location is CONFIGHOME\SASApp\ABMServer\config. 
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Here is an example of the backup command: 

Windows: 
AbmMdlMigration.exe -backup -src=”C:\SAS\Config\Lev1\SASApp 
\ABMServer\Models” -dst=”C:\ModelBackup\May2014” -appcfg=”C:\SAS 
\Config\Lev1\SASApp\ABMServer\config” > backup.log 

Linux: 
export LD_LIBRARY_PATH/local/install/users/cfgsas1/SASHome/ 
SASFoundation/9.4/sasexe:$LD_LIBRARY_PATH 

./AbmMdlMigration -backup -src=/local/install/users/cfgsas1/SrcModels 
-dst=/local/install/users/cfgsas1/DstModels -appcfg=/local 
/install/users/cfgsas1/SASConfig/Lev1/SASApp/ABMServer/config > 
backup.log 

When you are executing the Backup operation on Oracle Linux, perform the following steps: 

1. Perform steps 1 and 2 that are specified above.  

2. If the database for SAS Cost and Profitability Management is PostgreSQL, set the following 
path to the LD_LIBRARY_PATH variable: 
*/usr/local/lib:/usr/local/lib64:<SASHome>/AccessClients/9.4/PostgreS
QL/lib:<SASHome>/SASFoundation/9.4/sasexe” 

If the database for SAS Cost and Profitability Management is Oracle, set the following path to 
the LD_LIBRARY_PATH variable: 

*/usr/local/lib:/usr/local/lib64:<SASHome>/AccessClients/9.4/Oracle/ 
lib:<SASHome>/SASFoundation/9.4/sasexe” 

3. Run the backup utility. 

4. Close the Oracle Linux session and then log back on. 

5. Restart the Object Spawner. 

To restore SAS Cost and Profitability Management models, take the following steps on the Model 
Server: 

1. Verify that all users have logged out of SAS Cost and Profitability Management. 

2. Stop the SAS Object Spawner. 

3. Open a command window. 

4. Change the directory to one of the following: 

SASHOME\SASFoundation\9.4\abmiomsvr\sasexe (Windows) or 
SASHOME/SASFoundation/9.4/sasexe (Linux). 

5. Run the following command (note that variables are in italics): 

Windows:  
AbmMdlMigration.exe -restore -src=BACKUPFOLDER -dst=MDLFOLDER  
-appcfg=CONFIGFOLDER > restore.log 
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Linux:  
export LD_LIBRARY_PATH=SASHOME/SASFoundation/9.4 
/sasexe:$LD_LIBRARY_PATH./AbmMdlMigration -restore -src=<BACKUPFOLDER  
-dst=MDLFOLDER -appcfg=CONFIGFOLDER > restore.log 

Where: 

BACKUPFOLDER: Specifies the model backup folder. 

MDLFOLDER: Specifies the folder location where SAS Cost and Profitability Management 
models will be stored on the Model Server. The default location is 
CONFIGHOME\SASApp\ABMServer\Models. 

CONFIGFOLDER: Specifies the configuration folder for SAS Cost and Profitability 
Management. The default location is CONFIGHOME\SASApp\ABMServer\config. 

Here are examples of the restore command: 

Windows: 
AbmMdlMigration.exe -restore -src=”C:\ModelBackup\May2014”  
-dst=”C:\SAS\Config\Lev1\SASApp\ABMServer\Models” -appcfg=”C:\SAS 
\Config\Lev1\SASApp\ABMServer\config” > restore.log 

Linux: 
export LD_LIBRARY_PATH:/local/install/users/cfgsas1/SASHome 
/SASFoundation/9.4/sasexe:$LD_LIBRARY_PATH./AbmMdlMigration  
-restore -src=/local/install/users/cfgsas1/DstModels -dst=/local/install 
/users/cfgsas1/Dst2Models -appcfg=/local/install/users/cfgsas1 
/SASConfig/Lev1/SASApp/ABMServer/config > restore.log 

The restore command first renames any existing models to give them a .bak file extension and then 
restores the models from the backup directory.  

When you are executing the Restore operation on Oracle Linux perform the following steps: 

1. Perform steps 1 and 2 that are specified above. 

2. If the database for SAS Cost and Profitability Management is PostgreSQL, set the following 
path to the LD_LIBRARY_PATH variable: 

*/usr/local/lib:/usr/local/lib64:<SASHome>/AccessClients/9.4/PostgreS
QL/lib:<SASHome>/SASFoundation/9.4/sasexe” 

3. If the database for SAS Cost and Profitability Management is Oracle, set the following path to 
the LD_LIBRARY_PATH variable: 

*/usr/local/lib:/usr/local/lib64:<SASHome>/AccessClients/9.4/Oracle/l
ib:<SASHome>/SASFoundation/9.4/sasexe” 

4. Run the Restore utility. 

5. Close the Oracle Linux session and then log back on. 

6. Restart the Object Spawner.   
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Appendix D – ODBC Data Sources on Linux 
The ODBC Data Source Names (DSNs) are defined on Linux (and other UNIX platforms) in text files 
(odbc.ini and odbcinist.ini) and by exporting two shell variables:  ODBCINI and ODBCINST. Make 
sure that the two .ini files are accessible and that variables are defined for all SAS Cost and 
Profitability Users (both interactive and system). The contents of odbc.ini and odbcinst.ini are 
determined by ODBC Manager and the database driver.  

Note: SAS Cost and Profitability Management includes the required ODBC drivers for both Oracle 
and PostgreSQL. For Oracle, it is deployed at $SASHOME/AccessClients/9.4/Oracle. 
For PostgreSQL, it is deployed at $SASHOME/AccessClients/9.4/PostGres. 

Oracle 
SAS Cost and Profitability Management uses the non-wired DataDirect driver for Oracle. Add or 
update the following properties in the odbc.ini file (italics indicate values that are specific to your 
environment): 

[ODBC] section: 

• InstallDir=install_path_of_ODBC_driver 

For example, InstallDir=$SASHome/AccessClients/9.4/Oracle 

• TraceDll=install_path/lib/S0trc27.so 

For example, TraceDll=$SASHome/AccessClients/9.4/Oracle/lib/S0trc27.so 

[Oracle Wire Protocol] section: 

• Rename this section to match the name of the DSN that was used while configuring SAS Cost and 
Profitability Management.  

For example, ABMDSN_Lev1 

• Driver=install_path/lib/S0ora27.so 

Change this driver name and use the non-wired ODBC driver, S0or827.so. 

For example, Driver=$SASHome/AccessClients/9.4/Oracle/lib/S0or827.so 

• Database=database_name 

• HostName=Oracle_host 

• PortNumber=Oracle_server_port 

• EnableDescribeParam=1 

• EnableNcharSupport=1 

• ColumnsAsChar=1 

• ColumnSizeAsCharacter=1 

• IANAAppCodePage=106 

• ServerName=ServiceName 

Add or update the path to odbc.ini in the .profile and in 
$SASConfig/Lev1/level_usermods_env.sh. 
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You can define ODBCINI and ODBCINST variables at a global location, for example, /etc/profile. 
Or you can define them for a specific SAS installation configuration only. The best place to define the 
variables for a SAS installation is CONFIGHOME/level_env_usermods.sh.  

You must also modify the PATH and LD_LIBRARY_PATH variables to include database binaries and 
libraries.  

Here is an example of changes in CONFIGHOME/level_env_usermods.sh for Oracle: 

ORACLE_HOME=Oracle_installation_folder 
ORACLE_SID=Oracle_SID 
ODBCINI=$SASHOME/AccessClients/9.4/Oracle/odbc.ini 
ODBCINST=$SASHOME/AccessClients/9.4/Oracle/odbcinst.ini 
LD_LIBRARY_PATH=$SASHOME/AccessClients/9.4/Oracle/lib:$ORACLE_HOME/lib:
$LD_LIBRARY_PATH 
PATH=$SASHOME/AccessClients/9.4/Oracle/lib:$ORACLE_HOME/bin:$PATH 
 
export ORACLE_HOME 
export ORACLE_SID 
export ODBCINI 
export ODBCINST 
export LD_LIBRARY_PATH 
export PATH 

After modifying these files, you must restart the Object Spawner.  

PostgreSQL 
Add or update the following properties in the odbc.ini file (italics indicate values that are specific to 
your environment):  

[ODBC] section: 

• InstallDir=install_path_of_ODBC_driver 

For example, InstallDir=$SASHome/AccessClients/9.4/PostgreSQL 

• TraceDll=install_path/lib/S0trc27.so 

For example, 
TraceDll=$SASHome/AccessClients/9.4/PostgreSQL/lib/S0trc27.so 

[Postgres Wire Protocol] section: 

• Rename this section to match the name of the DSN that was used while configuring SAS Cost and 
Profitability Management.  

For example, name it ABMDSN_Lev1 

• Driver=install-path/lib/S0psql27.so 

Replace install-path with the actual path to the driver. 

For example, Driver=/install/SASHome/AccessClients/9.4/PostgreSQL 
/lib/S0psql27.so 

• Database=database-name 

• HostName=Postgres-Host 

• PortNumber=Postgres-Server-Port 
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Add or update the path for odbc.ini in the .profile and in 
$SASConfig/Lev1/level_usermods_env.sh. 

You can define ODBCINI and ODBCINST variables at a global location, for example, /etc/profile. 
Or you can define them for a specific SAS installation configuration only. The best place to define the 
variables for a SAS installation is CONFIGHOME/level_env_usermods.sh.  

You must also modify the PATH and LD_LIBRARY_PATH variables to include database binaries and 
libraries.  

Here is an example of changes in CONFIGHOME/level_env_usermods.sh for PostgreSQL: 

ODBCINI=$SASHOME/AccessClients/9.4/PostgreSQL/odbc.ini 
ODBCINST=$SASHOME/AccessClients/9.4/PostgreSQL/odbcinst.ini 
LD_LIBRARY_PATH=$SASHOME/AccessClients/9.4/PostgreSQL 
/lib:$LD_LIBRARY_PATH 
PATH=$SASHOME/AccessClients/9.4/PostgreSQL/lib:$PATH 
 
export ODBCINI 
export ODBCINST 
export LD_LIBRARY_PATH 
export PATH 

After modifying these files, you must restart the Object Spawner. 
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Appendix E – Enabling SSL on the Model Server 
If you are configuring SAS Web Application Servers to use HTTPS, you must also specify the security 
certificate on the Model Server.  

Linux 
Take the following steps to create the certificate on Linux: 

1. Create a .pem file for the chained certificate, if you have not done so already. Run the 
following command to create the file:  
openssl x509 -in .crt file with path –out .pem file with path-outform 
PEM 

2. Use your preferred text editor to modify the following file: 
CONFIGHOME/SASApp/ABMServer/ABMServer.sh  

Add the following to the CMD_OPTIONS variable: 
-SSLCALISTLOC .pem-file-with-path 

For example, if you generated the servercert.pem file in /usr/ssl, the CMD_OPTIONS in 
CONFIGHOME/SASApp/ABMServer/ABMServer.sh would look like this: 

CMD_OPTIONS= » -logconfigloc $CONFIGDIR/logconfig.xml –SSLCALISTLOC 
/usr/ssl/servercert.pem » 

3. Restart the Object Spawner. 

Windows 
Take the following steps to create the certificate on Windows: 

1. Open the Microsoft Management Console (MMC) by running mmc.exe as Administrator. 

2. If you do not have Certificate Manager installed in MMC, install it: 

a) From the File menu, select Add/Remove Snap In. 

b) Select Certificates from the Available Standalone Snap-ins dialog box, and click Add. 

c) Select Computer Account and click Next. 

d) Select Local Computer and click Finish. 

e) Click OK.  

3. In the left pane, expand Certificates (Local Computer)→Trusted Root Certification 
Authorities. 

4. In the left pane, locate Certificates (Local Computer)→Trusted Root Certification 
Authorities. Right-click Certificates and select All Tasks.  

5. Click Import. 

6. Browse to the certificate and click Next. 

7. Select Place all certificates in the following store and click Browse. 

8. In the Select Certificate Store dialog box, click Show physical store.  
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9. Expand Trusted Root Certification Authorities and select Local Computer. 

10. Click Next, and then Finish to import the certificate. 

11. Restart the Object Spawner. 
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Appendix F – Memory Settings 
This section describes the recommended memory settings for each server process that is used by 
SAS Cost and Profitability Management 8.4. This section does not provide physical memory 
requirements for various servers. The suggested memory settings apply to all server operating 
systems. 

Suggested Memory Settings on Servers 
Below are the suggested memory settings by model size. These values are estimates because the 
real memory consumption depends on multiple factors, such as the number of accounts, 
assignments, period/scenario, dimension structure, etc. For purposes of this document, the 
suggested memory allocation applies to all SAS servers.  

Small models 
Number of Accounts:  1,000 
Number of Assignments:  5-10 times the number of Accounts 
Suggested Memory:    1 GB 

Medium models 
Number of Accounts:  10,000 
Number of Assignments:  5-10 times the number of Accounts 
Suggested Memory:    2 GB 

Large models 
Number of Accounts:  200,000 
Number of Assignments:  5-10 times the number of Accounts 
Suggested Memory:    8 GB 

Huge models 
Number of Accounts:  1,000,000 
Number of Assignments:  5-10 times the number of Accounts 
Suggested Memory:    16 GB 

Adjusting Memory Settings on Servers 

Cost and Profitability Management Mid-Tier  
To adjust memory settings for the Middle Tier: 

1. Use your preferred text editor to modify the following file: 
SASConfig/LevelN/Web/WebAppServer/SASServer9_1/conf/wrapper.conf  

2. Change the value of – Xmx. The value is specified in MB. As an example, a max heap 
size of 2 GB would be -Xmx2048m. 

Specifying a maximum heap size does not necessarily mean that the Java process will 
take that much memory right away. Instead, this value specifies the maximum amount of 
memory that a Java process is allowed to allocate. 

3. Restart SASServer9 for the change in memory settings to take effect. 
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SAS OLAP Server 
If you experience memory-related issues while creating a SAS OLAP cube, the memory settings 
for the Workspace server that is generating the cube require modifications. Typically the 
Workspace server that is generating OLAP cubes is installed on the same machine as your OLAP 
server.  

Use your preferred text editor to modify the following file: 
SASConfig/Level/SASApp/WorkspaceServer/sasv9_usermods.cfg  

Increase the values for the following options (substitute actual values for the italicized variables): 

        -memsize memsizeG 

        -sortsize sortsizeG 

Both the memsize and sortsize values are in GB. For example, a memsize of 2 GB and a 
sortsize of 1 GB would be specified as follows: 

        -memsize 2G 

        -sortsize 1G 

SAS does not automatically reserve or allocate the amount of memory that you specify in the 
memsize or sortsize system option. Instead, SAS uses only as much memory as it requires to 
complete a process. 

A change in a Workspace server setting requires the Object Spawner to be restarted on that 
machine.  

Reference 
For more information, see SAS 9.4 Web Applications: Tuning for Performance and Scalability, located 
at https://support.sas.com/documentation/cdl/en/appsrvtuning/66878/PDF 
/default/appsrvtuning.pdf. 

 

 

 

https://support.sas.com/documentation/cdl/en/appsrvtuning/66878/PDF%0b/default/appsrvtuning.pdf
https://support.sas.com/documentation/cdl/en/appsrvtuning/66878/PDF%0b/default/appsrvtuning.pdf
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Appendix G –SAS Visual Analytics Report Migration 
This appendix describes the migration of SAS Visual Analytics reports from SAS Cost and 
Profitability Management 8.1, 8.1M2 and 8.1M4 to version 8.4M2. 

With SAS Cost and Profitability Management 8.1M5 and later, the SAS Visual Analytics reports 
are stored at the following location: /Products/SAS Cost and Profitability 
Management/VA Reports. In previous versions they were stored at /Products/Visual 
Analytics Administrator.  

Take the following steps to rebuild your reports at the new location after upgrading to version 
8.4M2. 

1. From SAS Cost and Profitability Management Client, launch the Metadata Server 
Options dialog box.  

2. Select CPM LASR library as your LASR library. 

3. Start the appropriate SAS LASR Analytic server. 

4. Review the list of tables on the LASR Tables tab. Notice that all of the existing tables 
defined are in the /Products/SAS Visual Analytics Administrator location. 

 
5. From SAS Cost and Profitability Management Client, perform the Export and Register 

Tables procedure. Make sure that the operation is successful and that the tables are 
registered successfully. 

6. From SAS Cost and Profitability Management Client, perform the Generate Cube 
procedure for the cube configuration with the Push to LASR option selected.  

Verify that the operation has succeeded, and that the tables are registered correctly. 

7. Return to SAS Visual Analytics Administrator. 

8. Review the list on the LASR Tables tab. Note that the new tables are loaded in the 
location /Products/SAS Cost and Profitability Management/VA Reports (with 
green indicators). The old tables that are not loaded are in the old location, 
/Products/Visual Analytics Administrator, and have a red indicator. 
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9. Open Report Builder and navigate to the report that you created in a previous release of 

SAS Cost and Profitability Management. 

 
10. Because the source table has a changed library location, you are prompted to change the 

data source.  
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11. Select the new table from the Products/SAS Cost and Profitability Management/Visual 
Analytics Reports location.  

 
 

 
12. Click OK. The following message is displayed: 

 
13. Verify that the report displays the same results that you saw before you updated your 

SAS solution software to release 8.4M2.  
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14. Save the report so that in the future, users can directly open it from Report Viewer and 

the error that instructs you to change the data source will not be displayed. 

15. Repeat steps 9 to 14 for all the other reports that were created in a previous release of the 
software. 

16. Return to SAS Visual Analytics Administrator and delete all the tables in metadata that 
refer to the old path: /Products/SAS Visual Analytics Administrator. Delete a 
table by selecting the check box and clicking Delete. 

 
17. You are prompted to confirm the deletion. 

After the Delete operation completes, the tables that are displayed in metadata inside 
SAS Visual Analytics Administrator are in the new location.  
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Appendix H – TLS 1.x Configuration 
SAS Cost and Profitability Management supports TLS 1.x-enabled SQL Server, Oracle, and 
PostgreSQL databases. This appendix describes the post-configuration steps that are required to 
enable TLS 1.x. This is an advanced topic, and you might want to contact SAS Technical Support 
for their guidance on this.  

Enabling TLS 1.x for Microsoft SQL Server Databases 
Before proceeding, verify that your instance of Microsoft SQL Server is TLS 1.x-enabled. For more 
information, refer to the Microsoft documentation. 

Important  Be sure to take a backup of the Registry before making any changes to it. 

1. Open the Windows Registry and verify that all the protocols (SSL 2.0, SSL 3.0, TLS 1.0, 
TLS 1.1, TLS 1.2, TLS 1.3) are available under Computer  → HKEY_LOCAL_MACHINE 
→ SYSTEM → CurrentControlSet → Control → SecurityProviders → SCHANNEL. If 
any are missing, you must add them. 

Take these steps on all the SAS Cost and Profitability Management servers, including the 
client machines.  

Create two keys named “Client” and “Server” under each of the protocols, each with two 
DWORDs named “DisabledByDefault” and “Enabled”.  

Under the keys, you can set the value for the protocol for which you are doing the 
configuration. Here is an example:  

For TLS 1.3 → Client and TLS 1.3 → Server, set the value of DisabledByDefault=0 
and the value of Enabled=1 if you are configuring TLS 1.3. Under the other client and 
server keys that are displayed, set the values of DisabledByDefault=1 and the value 
of Enabled=0. 

2. Verify the domain name. 

The computer name must be the fully qualified domain name (FQDN). For example, 
myComputer010.myDirectory.sas.com uses the correct syntax. If it is not the 
FQDN, add the domain name (for example, sas.com) to the computer name. 

Take the following steps: 

o Access the Properties panel on your computer (on Windows, right-click the 
Computer icon on your desktop and select Properties). 

o Click Advanced system settings in the left pane. 
o Click the Computer Name tab. 
o Click Change. 
o Click More. 
o Enter your domain name in the Primary DNS suffix field. 
o Click OK and restart the computer. 
o Verify that your full computer name is now the FQDN. 

Take these steps on the Mid-tier, Compute-tier, and Database machines. 

3. Make the following changes in the settings.xml file on the Compute-tier machine: 

o Locate the following file: $DRIVE:\SAS Config 
Folder\Lev1\SASApp\ABMServer\config\settings.xml 
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o Update the following tag above the </settings> section: 
<!--  
    Specify if the Database is TLS Enabled. 1 if Yes 0 if No 
  --> 

 <TLSEnabled>1</TLSEnabled> 

o If the database is TLS-enabled, the value will be 1; otherwise, it is 0. 
4. Make the following changes in the server.xml file on the Middle-tier machine: 

o File location:  $DRIVE:\SAS Config Folder\Lev1\Web\WebAppServer 
\SASServer9_1\conf\server.xml 

o Add the tag “encrypt=true;TrustServerCertificate=false;” in the 
URL field of the SQL Server resource tag. 

It should resemble the following example: 
<Resource auth="Container" 
driverClassName="com.microsoft.sqlserver.jdbc.SQLServerDriver" 
factory="com.sas.vfabrictcsvr.atomikos.BeanFactory" maxPoolSize="100" 
minPoolSize="10" name="sas/jdbc/abmDS" password="${pw.sas.jdbc.abmDS}" 
testQuery="SELECT 1" 
type="com.atomikos.jdbc.nonxa.AtomikosNonXADataSourceBean" 
uniqueResourceName="sas/jdbc/abmDS" 
url="jdbc:sqlserver://rdcesx16040.race.sas.com:1433;DatabaseName=cpmdb;
encrypt=true; TrustServerCertificate=false;" user="cpmuser"/> 

5. Perform ODBC driver updates on SAS Mid-tier machines that have TLS 1.x enabled. 

Verify that the SQL Server Native Client Driver on the Compute-tier machine is 
compatible with TLS 1.2. For more information, refer to the relevant Microsoft 
documentation. 

For SQL server 2022, you must use ODBC Driver for SQL server version 18 to configure 
TLS 1.3. 

6. Update the sqljdbc driver JAR file corresponding to your database version to the one that 
supports TLS 1.x. It is required to support TLS 1.x from Microsoft.  

This driver must be updated in the following location on the Mid-tier machine: 
$DRIVE:\SAS Config Folder\Lev1\Web\WebAppServer\SASServer9_1\lib 

7. Add a property to SAS Management Console: 

o Launch SAS Management Console and log in with an Unrestricted ID (for 
example, use the sasadm@saspw account). 

o Add the following property to Application Management → Configuration 
Manager → Cost and Profitability Mgmt 8.4 → Properties → Advanced tab: 

Property Name: data.abmserver.db.host.tls.enabled 

Property Value: true 

8. Restart the SQL Server and SSAS (if present) services on the Database machine. 

9. Restart the SASServer9_1 webapp server and Cost and Profitability Service (if present). 

10. Restart the Object Spawner service. 

Enabling TLS 1.x for Oracle Databases 
Before proceeding, perform a deployment of SAS Cost and Profitability Management with 
Oracle, where SAS Web Server is TLS-enabled and Oracle is not TLS-enabled. For more 
information, refer to your Oracle documentation. 
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Oracle Wallet is a container that stores authentication and signing credentials. Trusted certificates 
are stored in the Oracle Wallet when it is used for security credentials. 

1. Perform a quick test on this setup to check that the application is working as expected 
before proceeding. 

2. Follow the post-deployment instructions provided below in order to enable TLS for 
Oracle using Oracle Wallet. 

3. Create Oracle Wallet: 

orapki wallet create -wallet wallet-location -auto_login 

The Oracle Wallet location should be under $ORACLE_HOME. 

Provide the password for the wallet. It should be more than 8 characters in length. 

4. Create the self-signed certificate and add it to the wallet: 

orapki wallet add -wallet "wallet-location" -dn "CN=host-name,C=US" -
keysize 2048 -self_signed -validity 10 -pwd password 

The CN name should be same as the host name (the FQDN). 

5. Display the contents of the wallet: 

orapki wallet display -wallet "wallet-location" 

6. Export the self-signed certificate: 

orapki wallet export -wallet "wallet-location" -dn "CN=host-
name,C=US" -cert certificate-name.cer 

7. Add the exported certificate into the SAS Java keystore: 
keytool -import -trustcacerts -keystore private-jre-path-with-cacerts 
-storepass password -alias alias -file “certificate-name.cer” 

You can use SAS Deployment Manager to add the certificate to the SAS JRE on all tiers as 
well. 

8. Add the certificate to the Oracle JRE: 
keytool -import -trustcacerts -keystore oracle-jre-path-with-cacerts 
-storepass password -alias alias -file "certificate-name.cer" 

If you have a database on another machine, be sure to import the Oracle certificates into 
the client’s Oracle JRE. 

9. Convert the ewallet.p12 file to ewalletKeystore.jks and ewalletTruststore.jks: 
orapki wallet pkcs12_to_jks -wallet "wallet-location" -pwd wallet-
password -jksKeyStoreLoc "ewalletKeystore.jks" -jksKeyStorepwd 
keystore-password -jksTrustStoreLoc "ewalletTruststore.jks" -
jksTrustStorepwd truststore-password 

10. Add both the JKS files to 
SASConfig/LevN/Web/WebAppServer/SASServer9_N/bin/setenv.sh. 

11. Append JVM_OPTS using the following string: 

-Djavax.net.ssl.trustStore=path-to-ewalletTruststore.jks -
Djavax.net.ssl.trustStorePassword=truststore_password -
Djavax.net.ssl.keyStore=path-to-ewalletKeystore.jks -
Djavax.net.ssl.keyStorePassword=keystore-password 
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12. Add the self-signed host certificate that we created for Oracle in 
SASHome/SASPrivateJavaRuntimeEnvironment/9.4/jre/lib/security/ 
jssecacerts: 

Here is an example: 

keytool -keystore jssecacerts -storepass password -import -
trustcacerts -alias alias -file path-to-certificatename.cer 

13. Add the SAS root CA and SAS intermediate CA certificates to ewalletTruststore.jks. 

Add the CA certs (root CA and intermediate CA) that are used for SAS Web Server TLS 
to ewalletTruststore.jks 

Here are some example commands: 
keytool -keystore ewalletTruststore.jks -storepass 
truststore_password -import -trustcacerts -alias alias -file path-to-
root.cer 

keytool -keystore ewalletTruststore.jks -storepass <truststore-
password> -import -trustcacerts -alias alias -file path-to-
intermediate.cer 

14. Add the certificate that you used for SAS Web Server TLS to ewalletKeystore.jks. 

Here is an example command: 
keytool -keystore ewalletKeystore.jks -storepass keystore-password -
import -trustcacerts -alias alias -file path-to-cert.cer 

15. Change the port and protocol. 

Change the port from 1521 to 2484 (TCPS port) and the protocol from TCP to TCPS in the 
following files: 

• tnsnames.ora 
• listener.ora 
• SASConfig/LevN/Web/WebAppServer/SASServer9_N/conf/server.xml 

• odbc.ini 
16. Modify the Oracle file sqlnet.ora: 

Make the following changes for TLS support: 
ENCRYPTION_WALLET_LOCATION = 
  (SOURCE = 
    (METHOD = FILE) 
    (METHOD_DATA = 
      (DIRECTORY = wallet-location) 
    ) 
  ) 
SQLNET.WALLET_OVERRIDE = FALSE 
SQLNET.CRYPTO_CHECKSUM_TYPES_SERVER = (MD5, SHA1, SHA256, SHA384, SHA512) 
SQLNET.AUTHENTICATION_SERVICES = (BEQ, TCPS, NTS) 
SSL_VERSION = 0 
SSL_CLIENT_AUTHENTICATION = FALSE 
SQLNET.ENCRYPTION_TYPES_SERVER = (RC4_128, 3DES112, RC4_56, DES, RC4_40, 
DES40, AES256, RC4_256, AES192, 3DES168, AES128) 
WALLET_LOCATION = 
  (SOURCE = 
    (METHOD = FILE) 
    (METHOD_DATA = 
      (DIRECTORY = wallet-location) 
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    ) 
  ) 
SSL_CIPHER_SUITES= (SSL_RSA_WITH_AES_256_CBC_SHA, 
SSL_RSA_WITH_3DES_EDE_CBC_SHA) 

 
Here is an example listener.ora file: 
SSL_CLIENT_AUTHENTICATION = FALSE 
 
WALLET_LOCATION = 
(SOURCE = 
   (METHOD = FILE) 
   (METHOD_DATA = 
      (DIRECTORY = wallet-location) 
    ) 
  ) 
 
LISTENER = 
  (DESCRIPTION_LIST = 
    (DESCRIPTION = 
      (ADDRESS = (PROTOCOL = TCPS)(HOST = host-name)(PORT = 2484)) 
      (ADDRESS = (PROTOCOL = IPC)(KEY = EXTPROC1521)) 
    ) 
  ) 

 
Here is an example tnsnames.ora file: 
ABMDSN = 
  (DESCRIPTION = 
    (ADDRESS = (PROTOCOL = TCPS)(HOST = host-name)(PORT = 2484)) 
    (CONNECT_DATA = 
      (SERVER = DEDICATED) 
      (SERVICE_NAME = ABMDSN) 
    ) 
  ) 
 
LISTENER_ABMDSN = 
  (ADDRESS = (PROTOCOL = TCPS)(HOST = host-name)(PORT = 2484)) 

 
17. Make the following changes to the odbc.ini file: 

ValidateServerCertificate=0 
EncryptionMethod=1 
Truststore=<orawallet>/ewallet.p12 
TrustStorePassword=truststore-password 
CryptoProtocolVersion=TLSv1.2,TLSv1.1,TLSv1  

18. Modify the files in SASConfig/LevN/SASApp/ABMServer/. 

These files are present on the SAS Compute tier. 

a) In the file SASConfig/LevN/SASApp/ABMServer/config/settings.xml, update 
the tag <TLSEnabled>. It is located above </settings>, as shown in the following 
example: 
<!-- Specify if the Database is TLS Enabled. 1 if Yes 0 if No --> 
 <TLSEnabled>1</TLSEnabled> 
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b) To enable SSL on the Model Server, modify the file
SASConfig/LevN/SASApp/ABMServer/ABMServer.sh. Add -SSLCALISTLOC to
the CMD_OPTIONS variable. Then update it to use the correct chain certificate, as
shown in the following example:

CMD_OPTIONS=" -logconfigloc $CONFIGDIR/logconfig.xml –SSLCALISTLOC
path-to-.pem-file"

Assuming that OpenSSL is in your PATH variable, you can use the following
command to create the .pem file using the chain certificate that you used to configure
SSL for the SAS Web Server:

openssl x509 -in path-to-.crt-file –out path-to-.pem-file -outform
PEM

c) Restart the SAS Object Spawner.

19. Add a property to SAS Management Console:

a) Launch SAS Management Console and log in with an unrestricted ID. For example,
you can use the sasadm@saspw account.

b) Add the following property to Application Management → Configuration Manager
→ SAS Application Infrastructure → Cost and Profitability Mgmt 8.4 → Properties
→ Advanced tab:

o Property Name: data.abmserver.db.host.tls.enabled
o Property Value: true

c) Update the port to 2484 from 1521 in the data.abmserver.db.port property.

20. Modify the file
SASConfig/LevN/Web/WebAppServer/SASServer9_N/conf/server.xml.

Change the existing Oracle connection string in server.xml to resemble the following
example:

jdbc:oracle:thin:@ABMDSN

21. Modify the file
SASConfig/SASPrivateJavaRuntimeEnvironment/9.4/jre/conf/security/java
.security:

Add the property
security.provider.N=oracle.security.pki.OraclePKIProvider under the List
of providers with the appropriate numbers as shown in the following example:

security.provider.9=SunPCSC

security.provider.10=JdkLDAP

security.provider.11=JdkSASL

security.provider.12=SunPKCS11

security.provider.13=oracle.security.pki.OraclePKIProvider

22. Add read permission for the iomuser account to the Oracle Wallet files. It is required for
Cube Generation.

23. Restart Oracle, the Listener, the SAS Object Spawner, and SASServer9.
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• While performing any keytool operations for Oracle ewallet.p12, use the keytool from
$ORACLE_HOME/jdk/jre/bin.

• While performing any keytool operations for jssecacerts, you should use the keytool from
$SASHOME/SASPrivateJavaRuntimeEnvironment/9.4/jre/bin.

• For each of the changes made in the odbc.ini, to validate them you should use 'isql' with -v
option to catch and remediate the errors.

• For each of the certificate changes you make, restart the SASServer9_1 for the changes to take
effect.

• Add the relevant certificates to the SAS Cost and Profitability Management Client machine
using SAS Deployment Manager

Enabling TLS 1.2 for PostgreSQL Databases 
If the PostgreSQL database is installed on Linux, contact SAS Technical Support for TLS-enabled 
PostgreSQL binaries. Update those binaries before proceeding further.  

Before proceeding, make sure that PostgreSQL is TLS 1.2-enabled. For more information, refer to 
your PostgreSQL documentation. 

Update the PostgreSQL database that is used by SAS Cost and Profitability Management: 

1. Update the Postgres JAR file.

Add the JAR file named postgresql-9.4.1212 (a compatible version that supports TLS 1.2)
in the following location on the Mid-tier machine:
config_folder/Lev1/Web/WebAppServer/SASServer9_1/lib

2. Modify the odbc.ini file on the Compute-tier machine.

For Linux environments, add the following tags in odbc.ini:

o Min_TLS=0
o SSLCertFile=path to root.crt/root.crt
o SSLKeyFile=path to server.key/server.key
o SSLMode=require

For Windows, configure SSLMode = require in the ODBC Driver Setup dialog box.

3. Make the following changes in the server.xml file on the Mid-tier machine:

Add “?ssl=true ?sslmode=require” in the URL field of the Resource tag for the
PostgreSQL database.

It will resemble the following example:
<Resource auth="Container" driverClassName="org.postgresql.Driver"
factory="com.sas.vfabrictcsvr.atomikos.BeanFactory" maxPoolSize="100"
minPoolSize="10" name="sas/jdbc/abmDS" password="${pw.sas.jdbc.abmDS}"
testQuery="SELECT 1"
type="com.atomikos.jdbc.nonxa.AtomikosNonXADataSourceBean"
uniqueResourceName="sas/jdbc/abmDS"
url="jdbc:postgresql://rdcesx10052.race.sas.com:10332/abmmodels?ssl=
true ?sslmode=require" user="cpmuser"/>

4. Add the exported certificate into the SAS Java keystore on the Mid-tier machine. For
example:
keytool -import -trustcacerts -keystore cacerts -storepass
password -alias alias -file “file-name”

Notes:
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You can also use SAS Deployment Manager to do this. Be sure to verify that the 
certificate was imported using the keytool command.  

5. Make the following changes in the settings.xml file on the Compute-tier machine: 
(C:\SAS\Config\Lev1\SASApp\ABMServer\config\settings.xml): 

Update the following tag, located above the </settings> section: 
<!--  
     Specify if the Database is TLS 1.2 Enabled. 1 if Yes 
0 if No 
    -->  
 <TLSEnabled>1</TLSEnabled>  

If the database is TLS-enabled, then the value will be 1; otherwise, it is 0.  

6. Add a property to SAS Management Console: 

a) Launch SAS Management Console and log in with an Unrestricted ID. For example, 
use the sasadm@saspw account. 

b) Add the following property to Application Management → Configuration Manager 
→ Cost and Profitability Mgmt 8.4  → Properties → Advanced tab: 

o Property Name: data.abmserver.db.host.tls.enabled 
o Property Value: true 

7. Restart the PostgreSQL server. 

8. Restart the Object Spawner service and SAS server 9. 
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